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INTRODUCTION 
WELCOME TO ONESOURCE GLOBAL TAX FOR SAP 
ARIBA SOLUTIONS 
Corporations using SAP Ariba Procurement Solutions can improve their tax accuracy by integrating with 
the ONESOURCE Global Tax for SAP Ariba Solution. This solution enable   Buying Organizations get fast, 
accurate tax (Sales, Use, GST and VAT like) results on procurement transactions and a complete audit 
trail from which you can generate both standard and custom reports, as well as information to assist in 
returns preparations(audit functionality will be part of future release). .   

The ONESOURCE Global Tax for SAP Ariba Solutions makes the tax calculation process easy by 
eliminating the need for preparing the complex tax master data like tax codes, rates, jurisdictions and 
other look ups manually. The very basic and easy tax master data would suffice in addition to web service 
configuration to get tax rates from globally recognized, robust tax engine backed up by dynamic tax 
content. 

This solution covers Use Tax, GST and VAT like taxes except taxes for Brazil for SAP Ariba Buying 
(previous product name: Ariba Procure-to-Order), SAP Ariba Buying and Invoicing. (Previous product 
name: Ariba Procure-to-Pay), SAP Ariba Invoice Management (previous product name: Ariba Invoice 
Professional) using SOAP based web services. 

WHO SHOULD READ THIS GUIDE? 
If you are responsible for overseeing setting up ONESOURCE Global Tax for SAP Ariba Solutions, you 
will need to coordinate help from the following people: 

• SAP Ariba Procurement Solutions Business Systems Analyst 
• SAP Ariba Procurement Solution Configuration Consultant 

  
Make this guide available to each of these contributors to ensure you have a successful installation. 

PREREQUISITES 
For a seamless and successful deployment of Integration for SAP Ariba Solutions follow all instructions 
within this guide. 

When working on Integration for SAP Ariba you must have a deep knowledge of the SAP Ariba 
Procurement Solution features and functionality covering all aspects of SAP Tax Code concept, SAP 
Ariba Tax Master Data, SAP Ariba Master Data maintenance by using Import/Export Tasks, SAP Ariba 
Integration Task configuration as an expert configurator or consultant in these areas. We recommend that 
you assemble a team to implement this product because it requires both functional and technical input. 
Your team should include someone who thoroughly understands business requirements and processes 
and web service and SOAP integration concepts. 
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The following tasks are expected to be completed before ONESOURCE Global Tax for SAP Ariba 
Solutions is configured in Customer’s Ariba instance: 

Task Task Name Description/Details Responsible Team 

1 SAP Ariba Customer and 
Thomson Reuters need to 
sign an agreement on 
ONESOURCE tax 
integration service 

SAP Ariba Customer and 
Thomson Reuters 
Professional Team 

2 Enable Tax API feature 
toggle in Ariba system 

Ariba Professional Team 

3 Set SAP Ariba site 
parameters required to be 
maintained for utilizing 
third-party tax calculation 
feature 

1. Application.Procure.En 
ableTaxCalculationInE 
xternalSystems 

2. Application.Procure.En 
ableTaxesChargesAnd 
Discount 

3. Application.Procure.En 
ableIncoterms 

4. Application.Invoicing.U 
seTLCTaxEngine 

Ariba Professional Team 

SYSTEM PREREQUISITES 
The configuration involves creating a web service end point using SOAP communication protocol to 
request tax calculation service from cloud system to a cloud based system and does not involve any new 
software components installation. 

System Requirements 

SAP Ariba Procurement Solution 14s or Higher 

ONESOURCE Indirect Tax 
Determination TaxCalculationService version 2011-09-01 

ONESOURCE Global Tax for SAP 
ARIBA Solutions 

ONESOURCE Global Tax for SAP ARIBA Solutions 
1.0.0.0 
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SCOPE OF THIS SOLUTION 
The ONESOURCE Global Tax for SAP Ariba Solutions makes tax calculation process simple by 
eliminating the need for manual tax master data preparation. This integration solution utilizes 
dynamic tax content and robust tax engine making it easy for even the most complicated tax 
scenarios. 

The solution has been developed to comply with the following scope 

• SAP Ariba Procurement Solutions with version 14s or Higher. 

• Tax calculation using this product happens on SAP Ariba Purchase Requisitions (Goods, 
Services of type catalog or Non-catalog) and Invoice Reconciliation Documents (PO based, 
Non-PO based and ERS based). 

• Use Tax, GST and VAT like taxes are covered at global level except Brazil. 

RESOURCES 
Resource Description 

Customer Support 
Look for answers in the Knowledge Base, or open a support ticket on 
https://tax.thomsonreuters.com/support/onesource/indirect-tax 

Quick Reference Set 
up and Prerequisite 
Guide 

This guide lists the activities which are prerequisites and also the complete list 
with brief description of tasks. It also highlights the relevant task for each 
responsible team. 

Configuration Guide 
This guide instructs how to configure and setup the integration product to 
enable tax calculations using ONESOURCE Indirect Tax Determination. 

SUPPORT PROTOCOL 
The ONESOURCE Global Tax for SAP Ariba Solutions is built, maintained, and owned by Thomson 
Reuters Tax & Accounting Indirect Tax. The business unit has a dedicated group of employees who have 
built this product. SAP Ariba built the tax API within SAP Ariba hence they support the process of 
gathering data within SAP Ariba and making it available to the tax API. Thomson Reuters manages the 
data mapping from the SAP API to the Determination engine. In case of an issue with the ONESOURCE 
Global Tax for SAP Ariba Solutions, please follow below mentioned simple steps to open a support ticket 
with Thomson Reuters: 

1. Identify the potential issue and gather all necessary facts (log files, scenarios, configurations, 
screen prints). 

2. Provide steps to reproduce the scenario leading to the issue. 
3. Provide system environment information such as your SAP Ariba Procurement Solution version, 

Cloud Integration version.   ONESOURCE Indirect Tax Determination version and ONESOURCE 
Global Tax Integration for SAP Ariba Solutions integration version. 

4. Open a support ticket with Indirect Tax at 
https://tax.thomsonreuters.com/support/onesource/indirect-tax 

 

https://tax.thomsonreuters.com/support/onesource/indirect-tax/
https://tax.thomsonreuters.com/support/onesource/indirect-tax
https://tax.thomsonreuters.com/support/onesource/indirect-tax/?search=000026965
https://tax.thomsonreuters.com/support/onesource/indirect-tax
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STYLE CONVENTIONS 
Style conventions provide a guide as to how to interpret information. 

Bold text indicates most user interface elements, such as: 

• Data you are expected to enter, such as in a text field 
• Pages, buttons, tabs, and field names 
• Dialog boxes, drop-down lists, selections within lists, and check box titles 
• Windows 
• Menu items 

Italic text indicates the following: 

• File and folder names 
• Software programming terminology and executable files 
• Document titles 

CAPITALIZED text indicates keyboard commands, such as ENTER, or database components. 

Courier text indicates command-line input/output. 

<brackets> indicate user entry. For example, <host> indicates you should replace the text and angle 
brackets with your server name. 

Book titles are shown in italics and sections within a book are in quotation marks, such as “Tips and 
Tricks” in the ONESOURCE Indirect Tax User Guide. 

Indicates suggestions or additional, detailed information. 

Indicates important text that should be carefully reviewed before proceeding. 

ÿ
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APPLICATION OVERVIEW 
This chapter describes: 

• The purpose and benefits of the ONESOURCE Global Tax for SAP Ariba Solutions application 
• A high-level overview of the business process flow   
• A description of the program flow by which the process works 

PURPOSE AND BENEFITS 

The ONESOURCE Global Tax for SAP Ariba Solutions application enables an organization using SAP 
Ariba Procurement Solutions (SAP Ariba Buying, SAP Ariba Buying and Invoicing, SAP Ariba Invoice 
Management) to accurately and efficiently calculate, accrue, and record tax for SAP Ariba Purchase 
Requisitions and Invoices. 

This product enables Organizations to utilize tax calculation service from a robust tax engine backed up 
by world class dynamic and most up to date tax content. With very minimal master data maintenance, 
users can benefit from tax calculation on SAP Ariba approvable like Requisition, Invoice Reconciliation for 
domestic, foreign and cross-border tax scenarios from simple to complex in nature. 

When ONESOURCE Global Tax for SAP Ariba solutions is integrated with SAP Ariba Procurement 
Solution, time and effort required for manual tax master data maintenance is saved while accessing most 
up to date content in real-time. 

BUSINESS PROCESS 
Buyer Organization’s user (buyer/purchasing agent) initiates the procurement process by creating 
Purchase Requisition. During purchase requisition creation process tax call is made when user selects 
Update Taxes button. SAP Ariba sends the document level information relevant for tax calculation and 
ONESOURCE Global Tax for SAP Ariba Solutions determines, responds back with tax rate/amount, tax 
authority, SAP tax code, SAP Account Key (not visible in UI) and other tax data. Tax call on requisition is 
also made when user submits Requisition for approval and an approver approves the requisition. 

Once the Purchase Requisition gets approved, Purchase Order would be created automatically. The tax 
information from Purchase Requisition lines gets copied over to Purchase Order Line items. 

If transaction is relevant for receipts, receipts would be posted in Ariba Procurement Solution once Buying 
Organization receives the goods. As a next step in the process, Supplier can submit invoice. SAP Ariba 
Procurement Solution makes tax call on Invoice Reconciliation Document to verify taxes from Supplier. 

ONESOURCE Global Tax for SAP Ariba Solutions determines tax and sends response back with tax rate, 
tax amount, tax authority, SAP Tax Code, SAP Tax Account Key (not visible in UI). SAP Ariba 
Procurement Solution captures tax data from tax call response for reconciliation purpose. In case of 
exceptions, if user changes any data which might be relevant for tax re-calculation, the functional button 
Recalculate Tax can be used to get tax recalculated. 

When there is a difference between Vendor charged tax amount and ONESOURCE Indirect Tax 
Determination calculated tax amount, an exception would be raised. This could be under tax, over tax 
exception based on difference amount. During exception handling, user can use standard option of either 
selecting Vendor charged Tax amount (Accept Invoice Tax Amount) or ONESOURCE Indirect Tax 
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Determination proposed tax amount (Accept Expected Tax Amount). Based on user’s selection, Invoice 
total amount will be updated. If the selection results in an accrual, OK-To pay file would show tax accrual 
amount. 
In either case of exception resolution or no exceptions, once Invoice is reconciled and approved, OK-To 
Pay file will be exported to SAP ECC for payment processing as a next step. 

General Functional Information: 

• The ONESOURCE Global Tax for SAP Ariba Solutions was built to calculate taxes on SAP Ariba 
Purchase Requisition and Invoice Reconciliation Documents.   

• Tax call from SAP Ariba system is made when Purchase Requisition is submitted, approved and 
when a user selects Update Taxes button on Create Requisition screen. In case of Invoice 
transaction, tax call will be made during reconciliation process on Invoice Reconciliation 
document automatically. In case of exceptions (under tax, over tax) user may update Invoice and 
use Recalculate Tax functional button to recalculate tax or may also use Accept Invoice Tax 
Amount or Accept Expected Tax Amount options to handle the exceptions. 

In case of Tax calculation failed error, SAP Ariba buyer user need to contact ONESOURCE 
Indirect Tax Customer Support   for troubleshooting and issue resolution. 

• The TaxCalculationProvider.csv master data CSV file controls which combination of SAP 
Company Code and SAP Ariba Procurement Document Type can utilize tax calculation service 
from ONESOURCE Global Tax for SAP Ariba Solutions   The SAP Company Code and SAP Ariba 
Purchasing Document Type which are not maintained in the TaxCalculationProvider.csv can 
utilize SAP Ariba native tax solution. 
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PROCESS FLOW 
The exact procure to pay business process flow may vary by Buyer Organization practice, SAP Ariba and 
ERP system landscape but tax calculation service from ONESOURCE Global Tax for SAP Ariba 
Solutions is available on SAP Ariba Purchase Requisition and Invoice Reconciliation documents as a 
standard in this release. 

The following steps lists the process flow in a general procure to pay business transaction process: 

• The SAP Ariba Procurement Solution (SAP Ariba Buying, SAP Ariba Buying and Invoicing) 
makes tax call on purchase requisition when user submits the document for approval.   

• SAP Ariba Procurement Solution sends the data at document level which is relevant for tax using 
web service/SOAP message channel. 

• ONESOURCE Global Tax for SAP Ariba Solutions determines accurate tax data and responds 
back to SAP Ariba system with tax details (Tax Authorities, rate/amount, SAP Tax Code, SAP 
Account key and other information). SAP Ariba system captures data from tax call response and 
updates the details on Purchase Requisition line item. 

• If for any reason user would like to change purchase requisition (on allowed requisition and order 
statuses) tax will re-calculated upon update document submission and during approval process. 

• As per SAP Ariba Procurement standard functionality, Purchase Order would be created 
automatically once Purchase Requisition is approved. In addition to other data, tax data also gets 
copied to Purchase Order Line items and so there would not be other tax call on Purchase Order 
If tax is recalculated on change purchase requisition transaction, updated taxes would be copied 
over to purchase order line items similar to other changes. 

• As a next step, supplier receives the Purchase Order and may choose to confirm Order and send 
Advanced Ship Notice. Once Buyer Organization receives the goods/get services rendered, user 
posts the receipts (in case of receipt relevant transactions). Supplier submits Invoice for goods 
supplied or services rendered. 

• During Invoice posting (SAP Ariba Buying and Invoicing, SAP Ariba Invoice Management) system 
makes tax call on Invoice Reconciliation Document to verify taxes entered by Supplier. 

• ONESOURCE Global Tax for SAP Ariba Solution determines and proposes expected taxes. If tax 
data on Invoice Reconciliation document matches with what ONESOURCE calculated, taxes 
would be reconciled and if no other variances are found, invoice gets reconciled.   

But if there is any variance between tax information on IR document and what ONESOURCE 
Global Tax for SAP Ariba Solution’s expected tax, SAP Ariba system issues exceptions. 
Exception handling is SAP Ariba standard process. IR document has option to recalculate taxes. 
Buyer Organization’s user can trigger tax call by selecting Recalculate Tax option on IR 
document. In case of IR rejection, subsequent Supplier re-submission, tax call would be made 
automatically when Invoice is re-submitted similar to Invoice posting process. 

• This process flow would be similar irrespective of type of Procurement source like catalog or non-
catalog based items, PO based or Non-PO based Invoices and ERS based invoice. 
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The ONESOURCE Global Tax for SAP Ariba Solutions is built to make Tax calculation process simple 
and easy supported by robust tax engine and world class research based dynamic tax content. Utilizing 
the tax calculation service from ONESOURCE Global Tax for SAP Ariba Solutions enable SAP Ariba 
Customer to save time required to set up tax process in SAP Ariba and tax master data maintenance. 

And also being supported by dynamic tax content and robust tax engine, simple to complex and domestic, 
foreign and cross border tax scenarios can be handled. 
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Integration Framework 
The ONESOURCE Global Tax for SAP Ariba Solutions integration framework comprises of SAP Ariba 
Tax API communicating with ONESOURCE Tax Solution in real time using Web Services/SOAP protocol.   

SAP Ariba Tax API is designed to make web service call to external Tax calculation service provider for 
tax calculation service and receive response to update transaction documents. SAP Ariba Procurement 
Solution is configured with Web Service and End Point for ONESOURCE Global Tax for SAP Ariba 
Solutions.   During procurement transaction, Tax API is invoked to make external tax calculation. .   

ONESOURCE Global Tax for SAP Ariba Solutions receives tax call where ONESOURCE Integration 
enriches the SAP Ariba application data and hands it over to ONESOURCE Indirect Tax Determination 
for tax calculation purpose. Once tax is determined, response is converted per SAP Ariba message 
format by ONESOURCE Integration and sent over to SAP Ariba Tax API. SAP Ariba Tax API receives the 
response and updates the transaction documents with tax information received from ONESOURCE 
Global Tax for SAP Ariba Solutions. The tax call and response occur in real time to provide seamless 
integration between SAP Ariba Procurement Solution and ONESOURCE Global Tax for SAP Ariba 
Solutions.   

INDIRECT

TAX

THOMSON REUTERS

SAP Ariba TAXAPI ONESOURCE
Solutions Real-time Tax Calculation

ONESOURCE
Tax ServiceIntegration
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SAP ARIBA PROCUREMENT SOLUTION 
SET UP 
END POINT CONFIGURATION 
SAP ARIBA Procurement Solution uses Web Services channel using SOAP protocol to send request and 
receive response from ONESOURCE Global Tax for SAP Ariba Solutions tax calculation service. 

SAP ARIBA Procurement Solution SOAP web services include integration tasks which require end point 
to request and receive response through logical communication channel. End point consists of URL and 
an authentication process which controls the access to that end point. End points can be of type inbound 
or outbound. Here we need outbound end point to make tax calls to ONESOURCE Global Tax for SAP 
Ariba Solutions.   SAP Ariba initiates the call using outbound end point. 

Users with roles/authorization groups Customer Administrator/Integration Administrator can be 
able to configure end point. 

The following steps with screenshots from SAP Ariba Procurement Solution explain configuration 
process: 

1. Log in to SAP Ariba Solution (SAP Ariba Buying and Invoicing, SAP Ariba Buying, SAP Ariba 
Invoice Management) 

2. On the SAP Ariba Spend Management dash board navigate to Manage > Core Administration 

  

HOME PROCUREMENT INVOICING CATALOG MORE... Recent- Manage Create T

Administration Purchase Orders

Payment Payment ID ERP Payment # Supplier Invoice # Purchas Approval Processes Queues

Contracts Receive

Common Actions
To Do Core Administration Reconcile Charges

Create My Tasks Reconcile Invoice

Requisition ID ÿ Date From Status
My To Do Report Search Filters

Analytical Report No items
Payments Supplier Knowledge

Supplier
Personal Workspace Unassigned Charges

Customer My Documents
More Prepackaged Reports

ID Title Date ÿ
Manage Public Reports
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3. SAP Ariba system opens a panel on left side of the home screen 

4. Click on End Point Configuration link found under Integration Manager.   

5. Click on Create New button to create an End Point.   

HOME PROCUREMENT INVOICING ADMINISTRATION

Recent Manage Create 
MORE...

Integration Manager
Site Manager
Data Import/Export

Audit Log

Integration Manager Data Import/Export Data Definition

Data Import/Export
Import and export data. View status, details, errors, and Review and accept changes to the data definition in

Data Definition the history of past data imports and exports. integration events.
Integration Configuration

Integration Configuration End Point ConfigurationEnd Point Configuration

Integration Toolkit Security Search, edit, activate or deactivate data import/export Configure external systems connection information.
Master Data Default Values tasks. Search fields are case-insensitive and you can enter

HOME PROCUREMENT INVOICING ADMINISTRATION

Recent Manage Create 
MORE...

Integration Manager
Site Manager

Data Import/Export
s   g n    o  e n n n Audit Log

Integration Manager Data Import/Export Data Definition
Data Import/Export

Import and export data. View status, details, errors, and Review and accept changes to the data definition in
Data Definition the history of past data imports and exports. integration events.
Integration Configuration

End Point Configuration Integration Configuration EndPointConfiguration

Integration Toolkit Security Search, edit, activate or deactivate data import/export Configure external systems connection information.

Master Data Default Values tasks. Search fields are case-insensitive and you can enter
all or part of a name.

 

 

    

 
 

 
 

 
 

   
 

  
   

 
   

   

 

    

  
 

 
 

 

 

   
 

  
   

 

 
  

   

  



12 SAP Ariba Procurement Solution Set Up 

End Point Configuration 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

6. The user interface Create End Point has three sections i) General, ii) Web Services Security, iii) 
HTTP Authentication. 
SAP Ariba System offers user interface to enter end point URL, set up authentication method and 
to enter credentials. 

7. Maintain End Point Name, Type and Address: 

Under section General > 

1. Enter a desired Name for End point in input field Name ex: IndirectTax_ONESOURCE 
2. Select Outbound radio button for type of end point 

When end point type Outbound is selected, system will display a URL field >    
  
Enter URL for the end point on the target system (ONESOURCE Global Tax for SAP Ariba 
Solutions) 

HOME PROCUREMENT CATALOG ( ADMINISTRATION MORE... Recent Manage Create -

EndPointConfiguration
Site Manager
Data Import/Export

Audit Log Search for existing end points or create new end points. Search fields are case-insensitive and you can enter all or part of a name.

Integration Manager
Data Import/Export Search Filters: Add/Remove Search Filters

Data Definition End Point:
Integration Configuration

End Point Configuration Type: No Choice Inbound  Outbound Search List All
Integration Toolkit Security
Master Data Default Values

Master Data Manager
Name Type

Customization Manager No items

User Manager Create New

End Point Configuration-Create End Point Save Cancel
1.entera desired

name

General

Configure inbound and outbound integration end points. Optionally define a/Neb Services Security certificate and/or the HTTP authentication credential to use to secure theMore

2.selectradiobutton
Name. IndirectTax ONESOURCE forOutbound

3. enter URL for
Type. Inbound Outbound

end point

URL: * https://int-ariba-uat.hostedtax.thomsonreuters.com/ExternalTRTaxService/TaxService
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Thomson Reuters ONESOURCE Indirect Tax Professional Services would provide the end 
point address (URL) for your test and production System set up during implementation process. 

8. Scroll down the page to HTTP section to maintain credentials for HTTP Authentication 

1. Enter User ID in Login field and Password in Password and Verify Password fields 

2. Click on Save button to save the changes and to create the End point. 

The log in credentials that would be required here are same as log in credentials used for 
accessing ONESOURCE Determination system with “Source System” role. 

9. To verify the End Point created on End Point Configuration screen: 
  
1. enter name of the end point created in End Point input field > select Type as Outbound > 

click on Search 
2. System would display End Point created as shown below: 

ÿ

HTTPAuthentication

Specify HTTP authentication credential. Passwords are case-sensitive, and must be between 12 and 16 characters long. They can include any Latin characters and punctuationMore

1. enter log in
Login: aribadev credentials

Password:
2.click save

button
Verify Password:

Cancel

End Point Configuration

Search for existing end points or create new end points. Search fields are case-insensitive and you can enter all or part of a name

1.enter name ofendpoint
created (partial/full name)

Search Filters: 2.select Type: Add/RemoveSearchFilters

Outbound
End Point: IndirectTax

Type: No Choice Inbound Outbound
Search List All

4.search would return
endpoint that was created 3.ClickonSearch tofind

the endpoint created

Name Type

IndirectTax punoqino IP3
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ENABLING INTEGRATION TASK 
By enabling integration task we link end point to the integration task. Here the Integration Task Export 
Document Data to External Tax Calculation would be linked to the End Point created in earlier step. 

1. Navigate to Manage > Core Administrator > Integration Manager > click on Integration 
Configuration option 

2. Click on List All to list all Integration tasks   
Or 
Select Format: Web Service, 
Select End Point: (end point name created in Configure End Point Step)    

  
Choose Status: Disabled > click on Search button. 

3. System would display the integration task Export Document Data for External Tax Calculation 

4. Click on Actions button > Click on option Enable 

5. Now choose the Status Enabled under Search Filters section and click Search to confirm the end point 
activated. 

Search Filters:

Task Name:

Format: Web Service

End Point: IndirectTax

Status: Enabled Disabled Search List All

Configuration

Tasks ÿ Format Enabled Supported Formats

Export Document Data for External Tax Calculation
Web

Exports data on approvable documents (such as requisitions and invoice NoService [Web Service] Actions
reconciliations) to the external system for calculation of tax. 1IP3

Enable 

Disable
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Now, we have created End Point, activated it and linked it to Integration task which sends the data to 
ONESOURCE Global Tax for SAP Ariba Solutions. 
  

Search Filters:

Task Name:

Format: Web Service

End Point: IndirectTax

Status: Enabled Disabled Search List All

Configuration click on the task name link

Tasks ÿ Format Enabled Supported Formats

Export Document Data for External Tax Calculation Web
Exports data on approvable documents (such as requisitions and invoice YesService [Web Service] Actions
reconciliations) to the external system for calculation of tax.

Search Filters:

Task Name:

Format: WebService

End Point: IndirectTax

Status: Enabled Disabled Search List All

Configuration

Tasks ÿ Format Enabled Supported Formats

No items
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DATA IMPORT/EXPORT TASKS 
ONESOURCE Global Tax for SAP Ariba Solutions require following Import tasks to be maintained in 
order to calculate taxes accurately. These import tasks enable importing master data utilized during tax 
calculation. 

IMPORT EXTERNAL TAX CALCULATION PROVIDER TASK 
This task is useful to control the combination of SAP ECC Company Code and SAP Ariba Procurement 
approvable (Purchase Requisition, Invoice Reconciliation) for which Buyer Organization would like to get 
the tax calculation function by using 3rd party vendor in this case Thomson Reuter’s ONESOURCE Global 
Tax for SAP Ariba Solutions.   

The file structure is as follows: 

Field COMPANYCODE is SAP ECC Company Code (organizational unit) 

Field TAXSOURCE is always ThomsonReuters for utilizing tax calculation service from ONESOURCE 
Global Tax for SAP Ariba Solutions.   

Field APPROVABLENAME can have two values ariba.purchasing.core.Requisition which is SAP 
Ariba Procurement Document type for Purchase Requisition and 
ariba.invoicing.core.InvoiceReconciliation which is Invoice Reconciliation document. This allows 
enablement of tax calculations either for one process (requisition or invoice) or for both. 

Thomson Reuter’s ONESOURCE Indirect Tax Professional Services can assist with providing 
sample CSV import file. 

Import data in to SAP Ariba Procurement Solution similar to other master data imports which is also 
explained here as follows: 

Import Procedure: 

1. On the SAP Ariba Spend Management Dash board click > Manage > Core Administration
2. System would display a panel on left side of the Home Screen with work space option Integration

Manager

UTF-8ÿ1
COMPANYCODE,TAXSOURCE,APPROVABLENAME

430o,ThomsonReuters,ariba.invoicing.core.InvoiceReconciliation

20oo,ThomsonReuters,ariba.invoicing.core.InvoiceReconciliation

10oo,ThomsonReuters,ariba.invoicing.core.InvoiceReconciliation

2200,ThomsonReuters,ariba.invoicing.core.InvoiceReconciliation

30oo,ThomsonReuters,ariba.invoicing.core.InvoiceReconciliation

430o,ThomsonReuters,ariba.purchasing.core.Reguisition

20oo,ThomsonReuters,ariba.purchasing.core.Reguisition

10oo,ThomsonReuters,ariba.purchasing.core.Reguisition

2200,ThomsonReuters,ariba.purchasing.core.Reguisition

30oo,ThomsonReuters,ariba.purchasing.core.Requisition
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The task Import External Tax Calculation Providers cans also be found > Site Manager > Data 
Import/Export 

3. Click the expansion arrow for Integration Manager > Click on Data Import/Export option 
4. Find the task you want to enable. Select List All or enter search criteria and click Search 

5. Click on Import button to open the user interface for importing the data 

Data Import/Export

Exclamation marks (l) indicate tasks that completed with errors or warnings. Refresh the screen to show current status.

Download Data Dictionary
1. Enter search term to find an Import

Task (not case sensitive)

Search Filters:

Task Name: tax Search List All

2. Click Search
Import Export Web Service Status button

3. System would display
Import relevant Import Tasks here U Refresh Status

Tasks Integration Toolkit Namesÿÿ  Status Last Imported

Completed08/14/2017
Import Tax Codes 05:45:05 PM Import 

Import Company Code Tax Registration Completed08/14/2017
11:21:09 AM Import Numbers

Import Purchase Orqanization to Supplier 08/14/2017
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6. By default the import operation type Load is selected > Click on Browse button to find the
TaxCalculationProviderExport.csv file on user’s computer system > click Run to import the file.

7. Click OK to confirm the data import.

Data Import for Task "lmport External Tax Calculation Providers"

Choose the operation you want to perform. Browse or specify the file where you want to import the data.

1.Choose type of import operation
ex: for initial load choose Create

Select Import Operation: operation

Load

Create

modified.

Update Only

database, it is not created. If you do not want to modify a particular object, do not include it in the data file. This operation can cause
deactivated objects to be reactivated.

Deactivate

Deactivates objects in the database based on objects in the data file. If you do not want to deactivate a particular object, do not
include it in the data file.

2. locate csv data file
on your system

Enter the location of the TaxCalculationProvider.csv file:

Tax Import Files\IMPORT FILES\TaxCalculationProvider.csvBrowse.

Run Cancel

3. Click on Run button to
execute the import 

operation
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System would return to Data Import/Export user interface screen and shows the status > Import > Status 
as Completed. Please click on Refresh Status if Status showed as Processing until Status becomes 
Completed. 

Create

modified.

Update Only
Modifies existing objects only in the database using values in the data file. If an object in the data file does not already exist in the

deactivated objects to be reactivated.

Deactivate

Deactivates objects in the database based on objects in the data file. lf you do not want to deactivate a particular object, do not
include it in the data file.

Enter the loc
Confirm Data Import

Are you sure you want to run Import Tax Types?

OK Cancel

Run

Search Filters:

Task Name: tax Search List All

Import Export Web Service Status

Import U Refresh Status

Tasks Integration Toolkit NamesStatus Last Imported

08/14/2017Import Tax Codes Completed 05:45:05 PM Import

Import Company Code Tax 08/14/2017Completed 11:21:09 AM ImportReaistration Numbers 
Import External Tax Calculation Completed 08/11/2017

ImportProviders 05:58:20 PM
Import Supplier Tax Registration Completed 07/11/2017

05:12:48 PM ImportNumbers

Completed 01/25/2017
Import Tax Types? 07:51:09 PM Import
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In case of errors, Status column under Import table will be shown. 

1. Click on Completed hyper link to view the error, description and history

2. Click on Error Details to view the detail description of error and where the error has occurred.

  

Status

Completed ()

Details of the data import or export, including any errors that occurred, and the history of past data imports and exports are displayed below.

Details Error Details History

Process Start Date:12/08/201605:45:31PM

Last Processed: 12/08/201605:45:31PM

Status: Completed (!)

Records created:2

Records updated:0

Records deleted: 0

Records exported:D

Client Type:
Client Version:

ClientInformatic

Details Error Details History

61155282

Date: 12/08/2016 05:45:31 PM
Hide Details

Error Items

Item ID ÿSeverityFile Name Line Number  Error Message Other Addresses

Invalid field name SystemCommodityCode. Specify a field name that has
been used in the tax code lookup.
Invalid line item type for field name SystemCommodityCode.
Invalid dotted field path for field name SystemCommodityCode. Provide a
dotted field path that is valid for the specified line item type.
Error executing trigger IntegrationPostCreate on
[ariba.tax.core.TaxCodeLookupFieldMapping [Baseld 2765676267708

Error AE+ljuQoPvJsi8 zaj88pto.2g9qys0]] with data {
DottedFieldPath = "File ITaxCodeLookupFieldMap.csv" (line 13, column
DottedFieldPath): 'Description.CommonCommodityCode"
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IMPORT TAX TYPES TASK 
SAP Ariba Procurement Solution offers standard tax types by default but when Buying Organization 
enables their legal entities/SAP Company Codes to calculate taxes using ONESOURCE Global Tax for 
SAP Ariba Solutions, they need to maintain a comprehensive list of Tax Types provided by ONESOURCE 
Indirect Tax Professional Services. The list covers tax types on global level to ensure comprehensive tax 
regime coverage to provide error free tax results. Buyer Organization can maintain this TaxType.csv in 
addition to default tax types available in SAP Ariba Procurement Solution. 

The sample TaxType.csv file will be as follows: 

The CSV file has fields UniqueName which is the Tax Type name that can be recognized uniquely. The 
column Name can be same name similar to UniqueName or a descriptive name. The column Category 
has SAP Ariba standard values like 2 ore 64. 2 denote Indirect Tax and 64 denote Withholding Tax. Here 
2 is a fixed value that needs to be repeated for all Indirect tax types. 

The columns/data description of Tax Type import task is as follows: 

Field Required Description Sample Value 

Unique Name Yes String. References unique Name of Tax Type 
defined in SAP Ariba Procurement Solution VAT 

Name Yes Multilingual String. This is displayed on UI Value Added 
Tax 

Category Yes Integer. The category of the Tax Type 
2 is for Indirect Tax and 64 is for Withholding Tax 2 

Check with Thomson Reuter’s Indirect Tax Professional Services for an updated and up-to date list of Tax Types for your 
Production system set up. 

TaxType.csv

12345
UTF-8,

UniqueName,Name,Category
CBT,China Business Tax,2
COF,COFINS,2
CST,Central Sales Tax,2
CSU,County Sales/Use Tax,2

7 DPH,Dan z pridane hodnoty,2
ÿ EXC,Excise Tax,2
9 GCT,General Consumption Tax,2

ÿ
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IMPORT PROCEDURE 

The import tasks related to Tax are found under Site Manager Workspace. The navigation to the Data 
Import/Export task is as follows: 

1. Ariba Spend Management > Manage > Core Administration > Site Manager > Data Import/Export

2. Select import operation type Create, select the CSV file from the system and click on execute button.

Data Import/Export

Exclamation marks (l) indicate tasks that completed with errors or warnings. Refresh the screen to show current status.

DownloadDataDictionary

2. Click Search
Search Filters:

Task Name: tax type Search List All

1. enter search text
here

Import Web Service Status

3. syetm would 4. Click
Import display related tasks URefreshStatus

Tasks ÿ Integration Toolkit NamesStatus Last Imported

Import Tax Type Translations Import

Import Tax Types Completed 06/23/2017 11:27:37 AM Import
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3. System takes user to the Import UI screen and show the status which can be in progress or completed. 
If the status is in progress, click on Refresh Status to see the latest one. Status column and Task being 
imported shows the status and time stamp. 
  

Data Import for Task "lmport Tax Types"

Choose the operation you want to perform. Browse or specify the file where you want to import the data.

1. Choose type of import
operation.Ex:here choose
Create for Tax Types initial

Select Import Operation: load

Load

Create

Creates new objects in the database using values in the data file. If an object in the data file already exists in the database, it is not
modlified.

Update Only
Modifies existing objects only in the database using values in the data file. If an object in the data file does not already exist in the
database, it is not created. If you do not want to modify a particular object, do not include it in the data file. This operation can cause
deactivated objects to bereactivated.

Deactivate
Deactivates objects in the database based on objects in the data file. If you do not want to deactivate a particular object, do not
include it in the data file.

2. Locate the import
 file on your system

Enter the location of the TaxType.csv file:

oort FileslMPORT FILES\TaxTypeMaster Files\TaxType.csvBrowse.

Run Cancel

3. Click on Run button to
execute the import operation
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IMPORT TAXTYPEMAP TASK 
The Tax Type Map import task maintains the mapping between the normal Tax Types entered on 
Supplier Invoice with Tax Types defined in SAP Ariba Procurement Solution.   

The sample TaxTypeMap.csv data file is as follows: 

SAP Ariba Procurement Solution by default maintains mapping for standard tax types but when Buyer 
Organization intend to use Thomson Reuter’s ONESOURCE Global Tax for SAP Ariba Solutions for tax 
calculation service, it is required to maintain a comprehensive list of tax types recommended by Thomson 
Reuters ONESOURCE Indirect Tax Professional Services. 

The CSV data file has fields TaxLineType which is tax type defined in SAP Ariba Procurement Solution. 
Field Name represents the normal tax types found on Supplier Invoice. 

Search Filters:

Task Name.tax Search List All

Import Export Web Service Status

Import U Refresh Statu

Tasks Integration Toolkit Names Status Last Imported

Completed08/14/2017
Import Tax Codes 05:45:05 PM Import

Import Company Code Tax Registration Completed08/14/2017
11:21:09 AM ImportNumbers

Import External Tax Calculation Providers Completed08/11/2017
05:58:20 PM Import

Import Supplier Tax Registration Numbers Completed 07/11/2017
05:12:48 PM Import

01/25/2017
Import Tax Types? Completed 07:51:09 PM Import

Completed12/19/2016
Import Tax Type Mappings 04:15:31 PM Import

TaxTypeMap.csv

123456
UTF-8,

TaxLineType,Name

CBT,China Business Tax
COF,COFINS

CST,Central Sales Tax
CSu,County Sales/Use Tax

7 DPH,Dan z pridane hodnoty
ÿ EXC,Excise Tax

GCT,General Consumption Tax
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Field Required Description Sample Value 

Unique Name Yes String. References unique Name of Tax Type 
defined in SAP Ariba Procurement Solution VAT 

Name Yes Multilingual String. This the tax type found on 
Invoices 

Value Added 
Tax 

Please check with Thomson Reuters’ ONESOURCE Indirect Tax Professional Services for most 
updated Tax Type Mapping data. 

Once TaxTypeMapping.csv file is ready, it can be imported in to SAP Ariba Procurement Solution using 
import task Import Tax Type Mappings. Please refer steps under IMPORT PROCEDURE section of 
TAX TYPE IMPORT to import the data in to SAP Ariba Solution. 

IMPORT TAXTYPES TRANSLATION TASK 

The Tax Type Translations is an optional import and requited only when the Tax Types need to 
be in a particular language other than the English. 

The sample Tax Type Translations file is as follows: 

The data description of the Tax Type Translations is as follows: 

ÿ

ÿ

TaxType Translations.csv

123456UnigueName,Name,Language
CBT,China BusineSs Tax,French

COF,COFINS,French
CST,Central Sales Tax,French
CSU,County Sales/Use Tax,French

7 DPH,Dan z pridane hodnoty,French
EXC,Excise Tax,French

9 GCT,General Consumption Tax,French
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Field Required Description Sample 
Value 

Unique Name Yes String. References unique Name of Tax Type 
defined in SAP Ariba Procurement Solution VAT 

Name No Multilingual String. This is displayed on UI Value Added 
Tax 

Language Yes String. The language to which Tax Type is 
translated French 

The import tasks related to Tax are found under Site Manager Workspace. The navigation to the Data 
Import/Export task is as follows: 

Ariba Spend Management > Manage > Core Administration > Site Manager > Data Import/Export 

Once TaxTypeTranslation.csv file is ready, it can be imported in to SAP Ariba Procurement Solution using 
import task Import Tax Type Translations. Please refer steps under IMPORT PROCEDURE section of 
TAX TYPE IMPORT topic to import the data in to SAP Ariba Solution. 

IMPORT TAX CODES TASK 
Tax Codes import task enable maintenance of Tax codes in SAP Ariba Procurement Solution. Similar to 
other import tasks in SAP Ariba Procurement Solution, Tax Code import task offers UI to import tax code 
data. 

This import task consists of two import CSV files which are TaxCodeHeader.csv and TaxCodeDetail.csv. 
Import Tax Code Task UI offers option to import two CSV files in to the system in single step. 

For SAP Ariba Procurement Solution’s tax integration with ONESOURCE Global Tax for SAP 
Ariba Solutions, only TaxCodeHeader.csv import file with Tax Code data is required. And 
TaxCodeDetails.csv would be imported as an empty file for programmatic use. 

Sample TaxCodeHeader.csv file: 

ÿ

TaxCodeHeader.csv

1 UTF-8,,

23456
MWSKZ,Name,TEXT1,LAND1,State
AO,IDT Standard Output TAX Exempt,,US,
A1,IDT Standard Output TAX,,US,
AA,US is-exempt Output tax,,US,
AZ,AZ Input Tax,,US,

7 CO,IDT Standard 1 Use TAX Exempt,,US,
C1,IDT Standard Use TAX,,US,

9 C5,molex test account,,Us,
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The description of the fields for the TaxCodeHeader.csv is as follows: 

Field Name Required Description 

MWSKZ Yes 
String. The unique name of the tax code. A tax code 
can be updated or deactivated using this unique 
name. 

Name No MultiLingualString. User specified name which is 
displayed on UI 

TEXT1 No MultiLingualString. Additional information for the tax 
code like purpose 

LAND1 Yes String. The unique identifier of the Country for which 
the tax code is applicable 

State No String. The unique name of the state for states in the 
US 

TAX CODE HEADER IMPORT FILE PREPARATION 
The data required for TaxCodeHeader.csv should match your backend ERP system’s company code 
structure. It is therefore recommended to export the relevant company codes form SAP system. 

To prepare the TaxCodeHeader.csv file using Tax Code Data from SAP ECC System follow below steps: 

SAP Users with access to table browsing transaction SE16/SE16N and authorization to 
Company Code data can extract the Tax Code data using below steps.   

User need to find out Tax Procedure assigned to the Country of the SAP Company Codes before 
extracting tax code data from T007A table. 

1. First get the Country of the SAP Company Code for which TaxCodeHeader.csv is prepared for. This 
information can be found in SAP Table T001. 

2. Then find Tax Procedure assigned to Country in SAP table T005. 

Country of SAP Company Code:    



28 SAP Ariba Procurement Solution Set Up 

Enabling Integration Task 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

Tax Procedure for Country: 

General TableDisplay

BackgroundNumber of Entries ÿÿ

Table T001 Company Codes
Text table No texts

Layout

Maximum no. of hits 500 Maintain entries

Selection Criteria

Fld name 0.Fr.Value To value More Output Technical name

Client MANDT

Company Code 2000 BUKRS
Company Name BUTXT

City ORT01

Country

Tabletobesearched T001 Company Codes

Numberofhits 1

Runtime Maximum no.ofhits 500

Details

CoCode cty
2000 GB

General Table Display

Background Number of Entries ÿÿ

Table T001 Company Codes
Text table No texts

Layout

Maximum no.of hits 500 Maintain entries

Selection Criteria

Fld name 0.Fr.Value To value More Output Technical name

Client MANDT

Company Code 3000 BUKRS

Company Name ÿ BUTXT

City 1 ORT01

Country LAND1
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Once the Tax Procedure assigned to SAP Company Code is found, please follow below steps to extract 
Tax Code data: 

1. Log in to SAP ECC system 

2. Enter Transaction Code SE16N in Command Field and click on Green check mark   

3. System would display table browser UI 

DisplayofEntriesFound

Table tobe searched T005 Countries

Number of hits

Runtime Maximum no.ofhits 500

Details

Cty Procedure
GB ZTPGB

ÿ

SE16N

SAPEasyAccess-UsermenuforVENuK

ÿ other menu Create role Assian users Documentation

Favorites
ÿ /IDT/LOG-ONESOURCEIndirectTax->Reports->LogReader
ÿ /IDT/AUDIT_DATABASE-ONESOURCEIndirect Tax->Reports->Audit Database Tran
ÿ SALR87012357-AdvanceReturnforTaxonSales/Purchases

UsermenuforVENUK
ONESOURCE Indirect Tax
ONESOURCEIndirectTax-GoodsMovement
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4. Enter: 

A. Tax Procedure of the SAP Company Code found in earlier steps in to Procedure 
input field   

B. Tax Type = V (input tax) 

5. Click on Deselect All button as shown in below screenshot and Select Fields 
Procedure, Tax type and Description 

For Demo purpose here we used sample Tax Procedure ZTPFB. For Ariba Buyer Organization 
this could be any Tax Procedure configured for corresponding SAP Company Code. 

Please note that the tax codes data extracted from SAP ECC system is the same data which is 
maintained in ONESOURCE Indirect Tax Determination for the purpose of Tax Integration between SAP 
Ariba Procurement Solution and ONESOURCE Global Tax for SAP Ariba Solutions. 

First please list all the SAP Company Codes for which Tax Code Qualifier configuration is maintained in 
ONESOURCE Indirect Tax Determination for the input tax (tax types for Purchasing) for SAP Ariba 
Procurement solution tax integration purppose.Then extract Tax Code data for those company codes as 
explained in following steps. 

General Table Display
BackgroundNumber of Entries s ÿÿ

Table T007A Tax Keys
Text table T007S No texts
Layout
Maximum no. of hits 500 Maintain entries

Selection Criteria

Fld name Fr.Value To value MoreOutput Technical name 
Client MANDT
Procedure

Tax Code $ MWSKZ
$ ÿ ? PRUEF
$ ÿ MWART

$ ÿ MISWX
$ ÿ

EU code ÿ ?
Indicator: Tax code ÿ ?
Product code ? PROCD

ÿ TXIND
ÿ TXREL

Reporting cntry ÿ LSTML

ÿ
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6. Scroll down to find and select the field Description

7. Click on Execute button to display table contents for selected criteria, 

8. System would display Tax Code and Description data per selection criteria.

9. Use the following table to populate the TaxCodeHeader.csv using Tax Code data found in SAP
ECC System

General Table Display

Background Number of Entries AllEntries

Table T007A Tax Keys
Text table T007S No texts

Layout

Maximum no.of hits 500 Maintain entries

Selection Criteria

Fld name 0.Fr.Value To value More Output Technical name

Client MANDT

Procedure ZTPGB KALSM
Tax Code MWSKZ

Indicator: Error Mes

Tax type MWART

Tol.per.rate TOLERANCE

TgtTaxCde:EUAcq ZMVSKESA

TgtTaxCode:EUAq ZMVSK ESE

New Def.TaxCde NEWWDEFTAX

COFINSLaW 11BTAXLW4

PIS LaW 1BTAXLVW5

Description TEXT1

?

Proc. Tx Description

ZTPGB I1 IDT Standard Input DFLT
ZTPGB V0 IDT GB Standard Input Tax Exempt
ZTPGB V1 IDT GB Standard Input Tax
ZTPGB V2 IDT GB Reduced RateInputTax
ZTPGB V3 IDT GB Zero Rate Tax Input
ZTPGB V4 IDTGBReverse ChargeInput Tax
ZTPGB V5 IDT GB Deferred Tax Input
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Field 
Name Required Description SAP Field 

MWSKZ Yes 
String. The unique name of the tax 
code. A tax code can be updated or 
deactivated using this unique name. 

T007A-MWSKZ 

Name No MultiLingualString. User specified name 
which is displayed on UI T007A-TEXT1 (Description) 

TEXT1 No 
MultiLingualString. Additional 
information for the tax code like 
purpose 

Optional 

LAND1 Yes 
String. The unique identifier of the 
Country for which the tax code is 
applicable 

T007S-LAND1 or Country found for 
SAP Company Code in Table T001 

State No String. The unique name of the state for 
states in the US Optional 

10. Repeat the steps 1 to 7 under section TAX CODE HEADER IMPORT FILE
PREPARATION for each SAP Company Code for which tax integration is enabled in SAP
Ariba Procurement Solution.  

A single TaxCodeHeader.csv file can be used for Tax Code data of all Company Codes for which 
external tax integration is enabled in SAP Ariba Procurement Solution. 

TAX CODE DETAILS IMPORT FILE PREPARATION 
The CSV file with only header data as shown in below sample file is required. It is a shell/empty file 
required for programmatic use while importing the data in to SAP Ariba Procurement System. 

The sample TaxCodeDetails.csv is as follows: 

Both TaxCodeHeader.csv and TaxCodeDetails.csv files can be imported using Import Tax Code task user 
interface. 

The navigation to the Data Import/Export task is as follows: 

Ariba Spend Management > Manage > Core Administration > Site Manager > Data Import/Export 

Please refer steps under IMPORT PROCEDURE section of TAX TYPE IMPORT topic to import the data 
using Import Tax Codes import task. 

TaxCodeDetails.csv X

1 UTF-8,

2 MWSKZ,Seguence,Component,AppliedOn,LAND1
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IMPORT TAX CODES TRANSLATION TASK 
If Customer would like to maintain description of Tax Codes in language other than English, perform Tax 
Codes Translation Task. 

The data description of the file is as follows: 

Field Name Required Description 

UniqueName Yes String. The unique name of the tax code. A tax code can be updated or 
deactivated using this unique name. 

Name Yes The translated Name of the Tax Code (Name field in TaxCodeHeader.csv)   
MultiLingualString. This is displayed on UI 

Description Yes The translated description (TEXT1 field in TaxCodeHeader.csv)   
MultiLingualString. This is displayed on UI 

Language Yes String. The language to which the name and description have been translated 

Once the CSV file is prepared, to import tax code translation data file using Import Tax Code 
Translations import task, please refer steps under IMPORT PROCEDURE section of TAX TYPE 
IMPORT to import the data in to SAP Ariba Solution. 

IMPORT INCOTERMS TASK 
"Inco terms" are international rules for the interpretation of the most commonly used terms in international 
and domestic contracts of the sale of goods. 

Inco terms regulate the division of costs and the transfer of risks. 

SAP ERP System provides standard Inco terms through table TINC. The data from SAP ERP table TINC 
can used to populate the Incoterms.csv data import file in SAP Ariba Procurement Solution. 

The sample Inco terms import CSV file is as follows: 

Please follow below steps to extract Inco terms data from SAP ERP and import in to SAP Ariba 
Procurement Solution: 

Incotems.csv x

1 UTF-8,

2
3

INCO1,ORTOB,NAME1

FOB,YeS,FOB Boston
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Extract Inco terms Data From SAP ERP System 
1. Log in to SAP ERP system > enter SE16N in Command Field on home screen-SAP Easy

Access

2. Click on Green Check mark (enter button) to go to table UI

3. System will display table UI

SAPEasyAccess-UsermenuforVENUK

SE16N

SAPEasyAccess-UsermenuforVENUK

ÿother menu Create role Assign users Documentation

Favorites
 /IDT/LOG - ONESOURCE Indirect Tax -> Reports -> Log Reader
 /IDT/AUDIT_DATABASE - ONESOURCE Indirect Tax -> Reports -> Audit Database Tran

S_ALR_87012357-Advance RetumforTaxonSales/Purchases
1UsermenuforVENuK

SAPEasyAccess-UsermenuforVENUK

SE16N ?

SAPEasyAccess-UsermenuforVENUK

ÿOther menu Createrole Assion users Documentation

Favorites
/IDT/LOG -ONESOURCE Indirect Tax-> Reports ->Log Reader
 /IDT/AUDIT_DATABASE - ONESOURCE Indirect Tax -> Reports -> Audit Database Tran
SALR87012357-Advance Return forTaxonSales/Purchases

User menuforVENUK
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4. Enter Inco terms table TINC in input field Table and click Green check mark or Enter button 
on keyboard 

5. De-select all fields first and then select the fields which need to be downloaded as shown in 
below screenshots 

General Table Display

BackgroundNumber of Entries ÿÿ

Table
Text table No texts

Layout
Maximum no. of hits 500 Maintain entries

Selection Criteria

Fld name 0.Fr.Value To value More Output Technical name

General TableDisplay

BackgroundNumber of Entries ÿÿ

Table TINC Customers:Incoterms

Text table TINCT No texts

Layout
Maximum no.of hits 500 Maintain entries

Selection Criteria

Fld name 0.Fr.Value To value More Output Technical name

Client MANDT

Incoterms ÿ INCO1

Location mand. ÿ ORTOB

Title tr. loc. OITITLE

GI loading/POD
Description ÿ BEZEI
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6. Select Fields INCO1, ORTOB, BEZEI and then click on Execute button. 

7. System will display all entries per selection criteria: 

General Table Display

BackgroundNumber of Entries ÿÿ

Table TINC Customers: Incoterms

Text table TINCT No texts

Layout
Maximum no. of hits 500 Maintain entries

Selection Criteria

Fld name O.Fr.Value To value More Output Technical name

Client MANDT
Incoterms ÿ INCO1

Location mand. ÿ ORTOB
Title tr. loc. ÿ OITITLE

GI loading/POD OIG_GLPOD

Description BEZEI

General Table Display
lackground Number of Entries ÿÿ

Table Customers:Incoterms

Text table No texts
Layout

Maximum no. of hits 500 Maintain entries

Selection Criteria

Fld name 0. Fr.Value To value More Output Technical name
Client MANDT

Incoterms ÿ INCO1
Location mand. ORTOB

Title tr. loc. OITITLE

GI loading/POD OIG_GLPOD

Description BEZEI
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8. Click on download option to download the content to user’s computer system. 

9. Once data is downloaded, prepare a CSV file similar to the sample shown here: 
  

DisplayofEntriesFound

Table to be searched TINC Customers: Incoterms
Number of hits 16
Runtime 0 Maximum no. of hits 500

i Details

IncoTCty Description
CFR X Costs and freight
CIF X Costs, insurance & freight
CIP X Insured freight-free
COD X COD
CPT Freight-free
DAF X Border delivered
DDP X Delivered cleared by customs
DDU X Delivered not cleared by cust.
DEQ X Delivered from quay (cleared)
DES X Delivered from ship
EXW From plant
FAS X Free along side
FCA X Free freight
FH Free house
FOB X Free on board
UN Not free

Table to be searched TINC Customers: Incoterms
Number of hits 16

Runtime 0 Maximum no. of hits 500

Details
IncoTCty Description Spreadsheet
CFR X Costs and freight Word processing
CIF X Costs, insurance & freight

X Insured freight-free
Local File

CIP
COD X COD Send

CPT Freight-free office
DAF X Border delivered ABC Analys.
DDP X Delivered cleared by customs HTML download
DDU X Delivered not cleared by cust.
DEQ X Delivered from quay (cleared)
DES X Delivered from ship
EXW From plant
FAS X Free along side
FCA X Free freight
FH Free house
FOB X Free on board
UN Not free
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Sample file structure of Inco terms: 

File data definition: 

Field 
Name SAP Field Required Type and description Sample value 

INCO1 TINC-INCO1 Yes 
String. Refers to the Inco terms 
code or the unique internal 
identifier for the Inco terms. 

FOB 

ORTOB TINC-ORTOB No 
Boolean. Specifies whether 
location is applicable for the 
Inco terms. 

Yes 

NAME1 TINCT-BEZEI Yes String. Description for the Inco 
terms code. Free on board 

  The value “X” for SAP TINC-ORTOB should be specified as “Yes” and the value “Blank” for 
SAP TINC-ORTOB should be specified as a comma (,) in Incoterms.csv file. 

Once the import CSV file is prepared, it needs to be imported in to SAP Ariba Solution. 

The import tasks related to Inco terms are found under Site Manager Workspace in SAP Ariba 
Procurement Solution. 

The navigation to the Data Import/Export task is as follows: 

Ariba Spend Management > Manage > Core Administration > Site Manager > Data Import/Export 

Incotems.csv×

1 UTF-8,,
N INCO1,ORTOB,NAME1

3 CFR,Yes,Costs and freight
4 CIF,Yes,Costs, insurance & freight

CIP,Yes,Insured freight-free
6 COD,YeS,COD
7 CPT,,Freight-free

DAF,Yes,Border delivered
6 DDP,Yes,Delivered cleared by customs

10 DDU,Yes,Delivered not cleared by cust.
11 DEQ,Yes,Delivered from quay (cleared)
12 DES,Yes,Delivered from ship
13 EXW,,From plant
14 FAS,Yes,Free along side
15 FCA,Yes,Free freight
16 FH,,Free house
17 FOB,Yes,Free on board
18 UN,,Not free
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Please refer steps under IMPORT PROCEDURE section of TAX TYPE IMPORT to import the data using 
Import Inco terms import task. 

IMPORT INCO TERMS TRANSLATION TASK 
To maintain translation for Inco terms, the import task, Inco terms translations need to b maintained. 

The Inco terms Translations data definition is as follows: 

Field 
Name Required Type and description Sample value 

INCO1 Yes String. Refers to the Inco terms code or the unique 
internal identifier for the Inco terms. FOB 

Language No String. Refers to the language for the translation German 

NAME1 Yes String. Description for the Inco terms code. Free on board 

Prepare the file as shown in below sample CSV file using the Incoterms.csv file. Fields INCO1 and 
NAME1 from Incoterms.csv with a new field called Language makes up the Inco terms Translations.csv 
file. 

Once the CSV file ready using import task Import Inco terms Translations import the file in to SAP 
Ariba Solution. 

Please refer steps under IMPORT PROCEDURE section of TAX TYPE IMPORT topic to import the data 
in to SAP Ariba Solution. 

Incotems Translations.csv 

1 UTF-8,1
2 INCO1,NAME1,Language
3 CFR,Costs and freight,German
4 CIF,Costs,German
ÿ CIP,Insured freiqht-free,German
6 COD,COD,German
7 CPT,Freight-free,German
8 DAF,Border delivered,German
9 DDP,Delivered cleared by customs,German

10 DDU,Delivered not cleared by cust.,German
11 DEQ,Delivered from quay (cleared),German
12 DES,Delivered from ship,German
13 EXW,From plant,German
14 FAS,Free along side,German
15 FCA,Free freight,German
16 FH,Free house,German
17 FOB,Free on board,German
18 UN,Not free,German
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IMPORT PURCHASE ORGANIZATION TO SUPPLIER 
MAPPING TASK 
The import task Purchase Organization to Supplier Mapping is an existing task for SAP Variant of SAP 
Ariba Procurement Solution. But the import filed is updated with new field called INCO1 to refer Inco 
terms code maintained in Incoterms.csv import file. 

Inco terms are used by ONESOURCE Indirect Tax Determination. When buyer organization enables a 
SAP Company Code for tax calculation by Thomson Reuter’s ONESOURCE Global Tax for SAP Ariba 
Solutions, this import task need to be updated. 

The sample CSV file for updated import task Purchase Organization to Supplier Mapping is as follows: 

The new column INCO1 is added is seen in the sample file. Please use the values for INCO1column from 
Incoterms.csv import task. 

Once PurchaseOrgSupplierCombo.csv file is prepared use import task Import Purchase Organization 
to Supplier Mapping to import the data in to SAP Ariba Solution.   

Navigation path is as follows:   

Manage > Core Administration > Site Manager > Data Import/Export 

Please refer steps under IMPORT PROCEDURE section of TAX TYPE IMPORT to import the data in to 
SAP Ariba Solution. 

As this is an update to existing data, please use Update import operation type while importing the 
data. 

USING CUSTOM FIELDS IN TAX CALCULATION 

SAP ARIBA Customer can make use of Custom fields in the tax calculation process using ONESOURCE 
Global Tax for SAP Ariba Solutions. 

To accomplish this Customer need to follow the following steps: 

• Customer need to contact SAP ARIBA Customer Support for creating Custom fields. 
• SAP ARIBA Customer Support creates the Custom field(s) per Customer specification and marks 

the fields as tax influencing fields. 
• SAP ARIBA Customer then work with Thomson Reuter’s ONESOURCE Indirect Tax Professional 

Services to make Custom fields as part of external tax call. 

PurchaseOrgSupplierCombo.csvX

1 UTF-8,

2 EKORG,LIFNR,XERSY, INCO1,ZTERM

3 "0008 3010,X,1
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• Thomson Reuter’s Global Tax PS work with internal engineering team to map tax influencing
custom fields to User Attribute Elements in Tax Integration and Determination Tax policy.

• Customer and Thomson Reuter’s Global Tax PS team test the newly added Custom fields before
moving the changes to Production systems (Customer’s SAP ARIBA realm and ONESOURCE
Global Tax for SAP Ariba Solutions).

  

  

PROCUREMENT BUSINESS PROCESS-
TAX CALCULATION 
Tax calculation is integral part of Procurement transactions. In SAP Ariba Procurement Solution, Tax is 
calculated on Purchase Requisition and Invoice Reconciliation documents during Procure to Invoice 
business process. Tax calculated on Purchase Requisition is copied over to Purchase Order. During 
Invoice Reconciliation process tax entered on Invoice by Supplier is verified and expected tax is updated 
on Invoice Reconciliation Document. The tax calculation is handled by SAP Ariba Native tax engine which 
is made up of programmatic algorithms and user maintained Tax Master Data. 

Now with ONESOURCE Global Tax for SAP Ariba Solutions, integration feature available in SAP Ariba 
Procurement Solution, SAP Ariba Buyers can enable their Organizations/Legal Entities created in SAP 
Ariba Procurement Solution for external tax calculation service. 

Buyer Organization can enable their Organizations/Legal entities created in SAP Ariba Procurement 
Solution by following steps in Configuration section of this document. Once configuration is completed 
successfully and required Master Data is maintained, SAP Ariba Buyer can see tax calculation by 
ONESOURCE Global Tax for SAP Ariba Solutions on approvable documents like Purchase Requisition 
and Invoice Reconciliation. 

TAX CALCULATION USING ONESOURCE GLOBAL 
TAX FOR SAP ARIBA SOLUTIONS 
The integration of SAP Ariba Procurement Solution with ONESOURCE Global Tax for SAP Ariba 
Solutions would provide seamless and real time tax calculation service. With ONESORCE integration, 
Buyer Organization need not to maintain tax rates for each tax authority instead can rely on 
ONESOURCE Indirect Tax Determination System for complex tax component details, dynamic rate 
changes. ONESOURCE Indirect Tax Determination makes use of complex algorithms on dynamic and 
research based global tax content to determine to calculate accurate taxes. 
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The tax calculation takes place on Purchase Requisition and on Invoice Reconciliation Document. The 
details process flow is as following: 

1. Procurement business process normally starts with Purchase Requisition. During requisition
processing buyer user can calculate taxes by simply clicking on Update Taxes button (newly
introduced) available on requisition summary page (on top and bottom of the page).

Top of requisition summary page with Update Taxes button:
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Bottom portion of Summary page with Update Taxes button: 

2. SAP Ariba Procurement initiates the tax call and transmits document level information available
on requisition. Based on transaction information received for requisition and also based on
corresponding legal entity (ex: SAP Company Code on requisition) tax set up in ONESOURCE
Indirect Tax Determination, taxes are determined and amount is calculated.  

3. ONESOURCE Global Tax for SAP Ariba Solutions would responds back to SAP Ariba
Procurement Solution with tax information including tax authorities’ applicable, tax types’
applicable, tax rate applicable and tax amount calculated. SAP Ariba solution would update the
tax information on requisition document being processed. This whole tax call request and
response would occur in real time seamlessly. User can see the tax information under Taxes
column on Tax table on requisition page.

4. Buyer user can continue to process the requisition and either save for future processing or submit
for approval. When requisition is submitted for approval, tax call is made automatically to
determine and calculate taxes based on updated information available on requisition.

PR1319:AribaDemo Print Continue Shopping UpdateTaxes Delete Save Submit

Summary

Title: Ariba Demo CartSummary
OnBehalfOf VenuKotagiri ILOfficeSupplies(1) $3.000.00USD

DelayPurchaseUntil: ?
Total(1item) $3.000.00USD

CompanyCode: 3000(IDESUSINC)

MyLabels: ApplyLabel..

Deliver To: Requestor

Need-byDate:

SupplierPart#:3001_PhotoCopier2

CommodityCode:Photocopiers

Material Group:00601(OfficeMachines)

PurchOrg:3000(IDESUSA)

Vendor.3001(ILOfficeSupplies)
Lineltem Text

Contact ILOffice Supplies

Payment Terms:0001

Actions UpdateTotal

Continue Shopping UpdateTaxes Delete Save Submit
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Update Taxes button is an optional feature and buyer user may also simply submit the 
requisition without clicking on Update Taxes button. When user submits the requisition, tax call is 
made automatically and ONESOURCE Indirect Tax Determination would determine taxes and 
sends a response back to SAP Ariba Procurement solution. 

If Buyer SAP Ariba Procurement Solution is enabled for external budget check, it is 
advised to click on Update Taxes button to calculate taxes are included in the fund being 
checked for availability in external system.   

5. Once Purchase Requisition is submitted for approval and during approval process, approver with 
appropriate edit authorizations makes any changes to tax influencing fields would trigger an 
automatic tax call updating the taxes on requisition 

6. Response from ONESOURCE Global Tax for SAP Ariba solutions would be updated in 
requisition line items. Column Taxes would show tax amount being calculated. To view 
completed tax information user can click on Tax Amount hyper link or may choose Details 
button (button appears after document is either saved or submitted) on line item. 

7. Clicking on Tax Amount hyper link or choosing Details button would present tax details. 

ÿ

1ItemTotal Hide Details

No. Service Item Type DescriptionQty Unit Price Discount NetAmount ChargesTaxesÿ Amount

Multi-
Purpose each $3,000.00 USD USD$3.000.00USDPhotocopier-

$247.50USD $3,247.50USD
3001PCA

SupplierPart# 3001_PhotoCopier2

Commodity CodePhotocopiers

Material Group00601(OfficeMachines)

Purch Org:3000(IDESUSA)

Vendor.3001(ILOficeSupplies)
Line Item Text

Contact.ILOffice Supplies
Payment Terms:0001

Actions UpdateTotal
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8. Here user can see Tax Code A1 coming from ONESOURCE Global Tax for SAP Ariba Solutions. 
This is the SAP Tax Code configured in ONESOURCE Indirect Tax Determination during SAP 
Ariba customer set up in ONESOURCE system as part of Tax Code Qualifier configuration step. 
In addition to SAP Tax Code, ONESOURCE Global Tax for SAP Ariba Solutions also provides 
the SAP Account Key as part of tax response. The SAP Account key is not visible on UI but 
would be part of purchase order export and payment request export messages. The SAP Tax 
Code and Account Key are useful for tax postings in SAP ERP system. 

9. When requisition is finally approved, a Purchase Order is created automatically. In addition to 
other information, Tax information also gets copied over to Purchase Order from an approved 
requisition and so there would be no tax call would be made on Purchase Order. 
Purchase Order line items would be updated with tax information. Under Taxes column on PO 
Line item table tax amount copied from requisition can be seen. 

10. Clicking on Tax Amount hyperlink or Detail would present tax information details. 

1Item Total

TaxDetailsforLineItem1-Multi-PurposePhotocopier-3001PCA

Tax Code:A1,

TaxComponents

Name IsDeductibleRate AppliedOn Amount

StateSales/UseNo 6.25%USSG2:StandardSellercollectedusetaxappliesbecauseofsalefromoutsidejurisdiction.9980P$187.50USD

City Sales/Use No 1.0% USSG21:StandardSellercollectedusetaxappliesbecauseofsalefromoutsidejurisdiction.9981|P$30.00USD

DistrictSales/Use No 1.0% $30.00USD

TaxAmount: $247.50USD

OK

Summary Approval Flow Receipts Invoices Payments History

Order ID:PO424

Version:1

Title: Ariba Demo

Supplier:IL Office Supplies
Contact: IL Office Supplies

Close Order:Open

My Labels: Apply Label.

Line Items

1 Line Item Hide Details

Type ÿ ReqlD Qty Unit Description Supplier Part Number Price Discount  Net Amount ChargesTaxes Amount

Multi-

PR1319 each Purpose
Photocopier-3001_PhotoCopier2$3,000.00 USD $3,000.00 USD $247.50 USD$3,247.50 USD Detail
3001PCA
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11. When Purchase Order is routed to Supplier or either available on Ariba Network, Supplier would 
ship goods or render services. Buyer user up on receiving goods/services would create receipts 
as a general process if applicable. Supplier can submit Invoice either on Ariba Network or an 
Invoice agent may enter it in SAP Ariba Procurement Solution. 

12. During Invoice reconciliation process, SAP Ariba makes a tax call and exports information on 
Vendor Invoice. ONESOURCE Global Tax for SAP Ariba Solutions would perform tax calculation 
and responds back with expected tax rate, amount, tax authorities, the tax types and the tax code 
which is updated on Invoice Reconciliation line items. 

13. Navigate to Invoice Reconciliation > Line View > Line Items to view tax response from 
ONESOURCE Global Tax for SAP Ariba Solutions. 

   

  

Tax Details for Line Item 1 - Multi-Purpose Photocopier-3001PCA

Tax Code:A1,

TaxComponents

Name Is Deductible  Rate Applied On Amount

StateSales/Use No 6.25% USSG2: Standard Seller collected use tax applies because of sale from outside jurisdiction.|9980|P$187.50 USD

City Sales/Use No 1.0% USSG21: Standard Seller collected use tax applies because of sale from outside jurisdiction.|9981|P$30.00 USD

District Sales/UseNo 1.0% USSG21: Standard Seller collected use tax applies because of sale from outside jurisdiction.|9981|P$30.00 USD

Tax Amount:$247.50 USD

OK
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14. Clicking on Tax Amount hyper link under Taxes column on Line Items table or Details hyperlink 
as highlighted in above Screenshot would present details of tax information 

15. Clicking on Tax Amount shows tax details on same Invoice Reconciliation Page in a new window 

16.   Clicking on Details would open the Line item in a new page and shows Taxes details as below 
(scroll down the page to see tax details). 

User can see Tax Code A1, expected tax type, Tax Description, Expected Tax Rate, Tax Amount 
and other details (click on Table Options to include or delete fields on taxes details section). 

Taxes

TaxCodeA1 Taxes:$247.50USD

Description

TaxType TaxDescriptionAccrual+ ReferenceDate ExpectedTaxRateTaxableTotal Amount ExpectedTaxAmount

Districtsalesorusetaxesnotappliedbypoliticalboundaries District Sales/Use Sun,08Oct,2017 0% $3,000.00USD $30.00USD $30.00USD

Salesorusetaxesleviedbyacity CitySales/Use Sun,08Oct,2017 0% $3,000.00USD $30.00USD $30.00USD

0% FeedbackSalesorusetaxesleviedbyastate StateSales/Use Sun,08Oct,2017 $3,000.00USD $187.50USD $187.50USD

Header Taxes, Charges, and Discount

Name ÿ Exceptions Type Taxable Amount Amount Accounting Details

No items

Line Items

No. Description ExceptionsOrder Qty   Unit Price Discount ChargesTaxes ÿ Gross Amount AccountingDetails

Multi-Purpose Photocopier-3001PCA PO424 1 each $3.000.00USD $247.50 USD $3,247.50 USD (1) Details

Details Accounting Details Action

HeaderTaxes,Charges,and Discount

Nameÿ Exceptions Type TaxableAmount Amount Accounting Details

Noitems

LineItems

No. Description ExceptionsOrder QtyUnit Price Discount ChargesTaxesÿ GrossAmount AccountingDetails

1 Multi-PurposePhotocopier-3001PCA PO424 1 each $3,000.00USD $247.50.USD $3.247.50USD (1) Details

Details AccountingDetails Action
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17. If no validation errors and variance exceptions occur, Invoice Reconciliation would be successful 
and status would eventually turn to paying with Payment Request generated. Payment request 
would be exported to Buyer’s ERP system and as a next step payment process takes place in an 
end to end procure to pay business scenario. 

INVOICE RECONCILIATION - TAX VARIANCE AND 
EXCEPTION HANDLING 
There may be tax variance between taxes charged by Supplier on Invoice with what has been proposed 
by ONESOURCE Global Tax for SAP Ariba Solutions. ONESOURCE tax calculation logic is complex and 
considers all possible and available information in to consideration to determine most accurate, current 
and appropriate taxes for a given scenario. 

There are three exceptions can happen on Invoice Reconciliation document. 

1. Under-Tax variance exception:   

When Vendor charged tax amount is less than what has been calculated by ONESOURCE 
Global Tax for SAP Ariba Solutions, it results in under tax variance. 

2. Over-Tax variance exception: 

When Supplier charged tax amount is greater than what has been proposed by ONESOURCE, it 
would result in over tax variance exception. 

Under tax and Over tax variances can be accepted or rejected. And during acceptance of 
variance, buyer user can either accept Vendor charged tax amount or tax amount calculated by 
ONESOIRCE Global Tax for SAP Ariba Solutions. Tax accrual is calculated based on what has 
been accepted.   

Handling the under tax variance or over tax variance exception is not impacted with the 
introduction of external tax calculation. Only difference here is instead of SAP Ariba Native tax 
solution, external tax provider ONESOUORCE has provided expected tax details. This entire 
process of exception handling can be carried out as usual. 

3. Tax Calculation Failed exception: 

This exception is also usual exception seen when the Supplier provided tax type(s) would not get 
matched with what has been calculated by ONESOURCE Global Tax for SAP Ariba Solutions. 

This exception cannot be accepted. Exception handlers who were added on Invoice 
Reconciliation document can verify if tax types selected by Supplier are invalid based on what 
has been proposed by ONESOURCE Global Tax for SAP Ariba Solutions. Invoice can be 
rejected with comments to Supplier requesting for correct tax type selection.   

Supplier can re-submit Invoice with correct tax types which is then handled using regular 
workflow where Invoice Reconciliation would make a tax call and if Supplier charged tax amount 
and selected tax types are correct, reconciliation would be successful. 

If exception handler finds that problem could be with ONESOURCE Global Tax for SAP Ariba 
Solutions, then first buyer user needs to contact ONESOURCE Indirect Tax Professional 
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Services for resolving the issue. If problem exists with tax calculation service provider and issue 
has been fixed, exception handler can click on Recalculate Tax button to retrigger the tax call 
and get the tax response. 

TAX REGISTRATION NUMBERS 
SAP Ariba has created new data import tasks to import Buyer (Company) and Seller (Supplier) Tax 
Registration Numbers in SAP Ariba Procurement and Invoice Solutions. Using these import tasks, 
Customers can import registration numbers. 

As part of ONESOURCE Global Tax for SAP Ariba Solutions implementation, Customers need to run 
these import tasks to maintain registration numbers in SAP Ariba Procurement and Invoicing Solutions 
Registration numbers will be used on tax call request to ONESOURCE Indirect Tax Solution for accurate 
calculation of taxes 

ABOUT DATA IMPORT 
Please find sample CSV files and details about the data in this section. 

BUYER TAX REGISTRATION NUMBERS 
Sample CSV file: 

Details about the import data: 

CompanyCodeTaxRegistration.csv

12345
UTF-8,1
CompanyCode,Country,TaxRegistrationNumber
2000,GB,GB123456788

4300,IN,07ABCHE1234X122

4300,IN,82ABCDE1234X123

2000,GB,GB123456789
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Field Required Description Sample Value 

TaxRegistrationNumber Yes 
String (50) A unique 
internal identifier for 
the company code. 

VAT234432565 

CompanyCode Yes 
String (50) The unique 
internal identifier for 
country. 

3000 

Country Yes 

String (50) The tax 
registration number for 
the company code and 
country combination 

US 

SUPPLIER TAX REGISTRATION NUMBERS 
Sample CSV file: 

Details about the import data: 

Field Required Description Sample Value 

TaxRegistrationNumber Yes String (50). A unique internal identifier for 
the company code. VAT234432565 

Supplier Yes String (50). A unique internal identifier for 
the supplier. 0000000001 

Country Yes 
String (50). The tax registration number 
for the company code and country 
combination 

US 

SupplierTaxRegistration.csv

123456
UTF-8,1
Supplier,Country,TaxRegistrationNumber
2001,GB,GB123456789

9000,IN,28ABCHE1234X123

9000,IN,28ABCDE1234X123

9000,IN,07ABCHE1234X122
7 2001,GB,GB123456788
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  PERFORMING DATA IMPORT 
Importing these CSV files is similar to any other Ariba standard data import task. To import his data follow 
the navigation as explained below. 

Go to Manage > Core Administration > Site Manager > Data Import/Export

1. Enter search text (not case sensitive).
2. Select the Search button.
3. System displays requested import tasks.
4. Select the Import button to go to Import UI and to import data.

  

Data Import/Export

DownloadDataDictionary 1.enter search text 2. click on
(not case sensitive) Search button

Search Filters:

Task Name.registration Search List All

Web Service Status 4. click on lmportImport
button to go to Import
Ul and to import data

3. System displays
Import requested import tasks Refresh Status

Tasks Integration Toolkit Names  ÿStatus Last Imported

Import Company Code Tax Registration Completed08/17/2017 01:26:54 ImportNumbers
Import Supplier Tax Registration Numbers

Import
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5. Select Import Type operation.
6. Locate import CSV file on your system.
7. Select Run to import the data.
8. Select OK to confirm.

Data Import for Task "lmport Company Code Tax Registration Numbers"

Choose the operation you want to perform. Browse or specify the file where you want to import the data.

1.selectImportType
Select Import Operation: operation

Load
Creates and modifies objects i
data file already exists ir database, it is modified using the value in the data file.

Create
Creates new objects in the database using values in the data file. If an object in the data file already exists in the database, it is not modified.

Update Only
Modifies existing objects only in the database using values in the data file. If an object in the data file does not already exist in the database, it is not created. If you do not
want to modify a particular object, do not include it in the data file. This operation can cause deactivated objects to be reactivated.

Deactivate
Deactivates objects in the database based on objects in the data file.If you do not want to deactivate a particular object, do not include it in the data file.

2.locate import
Enter the location of the CompanyCodeTaxRegistration.csv file:CSV file on your
C:Usersluc216083\Documents\TR Ariba Test System\MasteBrowse... system

3.click on Run to
import the data

Run Cancel

Data Import for Task "lmport Company Code Tax Registration Numbers"

Choose the operation you want to perform. Browse or specify the fle where you want to import the data.

Select Import Operation:

Load
Creates and modifies objects in the database using values in the data file. If an object in the data file does not already exist in the database, it is created. If an object in the
data file alrea

Create Confirm Data Import
Creates new I the database, it is not modified.

Are you sure you want to run Import Company Code Tax Registration Numbers?
Update Onl

Modifies exis OK Cancel ot already exist in the database, it is not created. If you do not
want to modi ects to be reactivated.

Deactivate
Deactivates objects in the database based on objects in the data file. If you do not want to deactivate a particular object, do not include it in the data file.

Enter the location of the CompanyCodeTaxRegistration.csv file:
C:\Usersluc216083IDocumentsITR Ariba Test SystemlMasteBrowse.

Run Cancel
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4. Once import task is executed, system takes you back to the Import UI page > Import tab. System would 
show the status and date of completion for the import operation. 

5. Repeat the steps from 1 to 4 to import the Supplier Registration numbers for Import task Supplier Tax 
Registration Numbers. 

TAX TYPES IN ARIBA NETWORK 
HOW TO USE TAX TYPES FROM ARIBA BUYING IN 
ARIBA NETWORK 
Ariba Network is kind of a clearing house between Buyers and Suppliers allowing collaboration for 
exchange of Business documents. One of the medium which Ariba Network allows Suppliers to submit 
Invoices to Buyers is online where Suppliers can flip the Purchase Order to Invoice. Buyers control 
Invoice submission by Suppliers using configurable transaction rules in Ariba Network where it validates 
incoming Invoices against these rules. 

Buyers can make use of Invoice rule “Copy tax from purchase order to Invoices” to default tax information 
from Purchase Order to Invoice during the create Invoice process. 

Ariba Network offers default transaction rules, Supplier Group and Country specific rules. Customers 
implement these rules based on their requirement. So please evaluate the requirements to enable the 
rule and conflicts if any in the context of Customer’s overall Invoice rule policy. 

Download Data Dictionary

Search Filters:

Task Name: registration Search List All

Import Web Service Status Status column
indicatescompletionof
task

Import U Refresh Status

Tasks Integration Toolkit Names   ÿ ÿStatus Last Imported

Import Company Code Tax Registration Completed09/25/2017 11:25:26 ImportNumbers ? AM
Import Supplier Tax Registration Numbers Import
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ERROR HANDLING 
WHAT ERRORS INTEGRATION USER WOULD SEE IN 
SAP ARIBA SOLUTION 
Errors may occur during tax calculation process in ONESOURCE Global Tax for SAP Ariba Solutions for 
any reasons like missing master data or configuration. And when there is more than one error, 
ONESOURCE integration would return only most severe type of error to Ariba Solution. 

Customers can refer Support Protocol mentioned in this document for help on troubleshooting and 
resolution of the errors. 

APPENDIX I 
ARIBA REQUEST FIELDS MAPPING 

The current version does not offer Audit functionality so the field mapping listed here is only for tax calculation      
process only. 

Ariba Request TR Mapping Comments 

Header <Collection> 

variant Batch.Calling_System_Number 

partition Batch.Host_System 

item <Collection> 

partition N/A Set at batch level 

variant N/A Set at batch level 

TaxServiceExportReply <Collection> 

item <Collection> 

CompanyCode <Collection> 

UniqueName Invoice.External_Company_ID 

LineItems <Collection> 

item Line.LineID 

BillingAddress Line.Bill_To 
BuyerTaxRegistrationNumb 

er Line.Registrations.Buyer_Role Multiple values allowed 

ChargeDetail <Collection> not use by SAP Ariba (unsupported) 

ChargeAmount 
Line.Document_Amount.Gross_Amoun 

t not use by SAP Ariba (unsupported) 

Currency <Collection> not use by SAP Ariba (unsupported) 
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Ariba Request TR Mapping Comments 

UniqueName Invoice.Currency_Code not use by SAP Ariba (unsupported) 

ChargeType <Collection> not use by SAP Ariba (unsupported) 

UniqueName Line.Product_Code not use by SAP Ariba (unsupported) 

CommodityCode <Collection> 

UniqueName Line.Product_Code 

Description Line.Description 

CommonCommodityCode <Collection> 

UniqueName Line.Commodity_Code 

Domain Line.User_Element.Attribute41 

UnitOfMeasure <Collection> 

UniqueName Line.Qunatities.Qunatity.Uom 

LineType <Collection> 

UniqueName Invoice.User_Element.Attribute41 Used from first line 

NetAmount <Collection> 

Amount 
Line.Document_Amount.Gross_Amoun 

t 

Currency <Collection> 

UniqueName Invoice.Currency_Code Used from first line 

NumberInCollection Line.Line_Number 

ParentLineNumber Line.Related_Line_Number 

Quantity Line.Qunatities.Qunatity.Amount 
SellerTaxRegistrationNumbe 

r Line.Registrations.Seller_Role Multiple values allowed 

ShipTo Line.Ship_To 

SupplierLocation Line.Ship_From 

IncoTermsCode Line.Delivery_Terms 

IncoTermsDetail Line.Title_Transfer_Location 

TaxExclusion Line.Is_No_Tax.All 

If TRUE set to Is_No_Tax for 
Determination, Ariba response will 
have an empty line structure with 
only the NumberInCollection 
reference 

custom <Collection> 

CustomBoolean Line.User_Element.Value Value # mapped in integration layer 

CustomInteger Line.User_Element.Value Value # mapped in integration layer 

CustomMoney <Collection> 

Amount Line.User_Element.Attribute42 
AmountInReportingCurr 

ency Line.User_Element.Attribute43 
ApproxAmountInBaseC 

urrency Line.User_Element.Attribute44 

ConversionDate Line.User_Element.Attribute45 
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Ariba Request TR Mapping Comments 

Currency <Collection> 

UniqueName Line.User_Element.Attribute46 

CustomString Line.User_Element.Value 

DocumentDate Invoice.Invoice_Date 

Type Invoice.Document_Type 

OrganizationName Invoice.External_Company_ID 

OrganizationUnit N/A 
Only OrganizationName used to 
capture ERP Company Code 

UniqueName Invoice.Invoice_Number 

custom <Collection> 

CustomBoolean Line.User_Element.Attribute Value # mapped in integration layer 

CustomInteger Line.User_Element.Attribute Value # mapped in integration layer 

CustomMoney <Collection> 

Amount Invoice.User_Element.Attribute42 

AmountInReportingCurrency Invoice.User_Element.Attribute43 
ApproxAmountInBaseCurren 

cy Invoice.User_Element.Attribute44 

ConversionDate Invoice.User_Element.Attribute45 

Currency <Collection> 

UniqueName Invoice.User_Element.Attribute46 

CustomString Invoice.User_Element.Attribute Value # mapped in integration layer 
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ARIBA RESPONSE FIELD MAPPING 
Ariba Response TR Mapping Comments 

ExternalTaxResponseStatus <Collection> 

Description Invoice.Requst_Status.Error.Descrpiton 

ErrorCode Invoice.Requst_Status.Error.Code 

ErrorLocationPath 
Invoice.Requst_Status.Error.Error_Locatio 

n_Path 

Success Invoice.Requst_Status.Is_Success 

LineItems <Collection> 

item <Collection> 

ExternalTaxItem <Collection> 

item <Collection> 

AbatementPercent Tax.Basis_Percent 
If provided (times 100), if NIL set it 

to 100% default. 

BuyerTaxRegistrationNum 
ber Line.Tax.BUYER_REGISTRATION single value 

Category Tax.Tax_Type 

Description Tax.Authority_Type 

ExternalTaxType <Collection> 

UniqueName Tax.Authority_Type 

FormulaString 
Tax.Jurisdiction_Text | 

Tax.Rule_Order | Tax.Nature_of_Tax 
Concatenate the three fields with a 
pipe separator 

IsDeductible 
Tax.Tax_Type, = NR, set to "true", 

else to "false" 

PerUnit Tax.Fee.Amount 

Percent Tax.Tax_Rate 
SellerTaxRegistrationNumb 

er Line.Tax.SELLER_REGISTRATION single value 

TaxAmount <Collection> 

Amount 
Tax.Tax_Amount.Document_Amoun 

t 

Currency <Collection> 

UniqueName Invoice.Currency_Code 

TaxableAmount <Collection> 

Amount 
Tax.Document_Amount.Taxable_Ba 

sis.Amount 

Currency <Collection> 

UniqueName Invoice.Currency_Code 

TaxAccountKey 

AccountInstruction 
Tax.Erp_Tax_Code 

Take from first tax block. Left 2 
digits, will map right 3 digits to 
Account Key field once field added 
by Ariba 
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Ariba Response TR Mapping Comments 

InvoiceCitation 
Tax.Invoice_Description 

Tax.Jurisidcition_Text 

Jurisdiction text for tax types NL, 
RC, TR, ZE, ZC, else invoice 
description 

TaxAuthority Tax.Authority_Name 

custom <Collection> 

CustomString Tax.Authority_Name 

NumberInCollection Line.Line_Number 

TaxCode <Collection> 

Country <Collection> 

UniqueName Tax.Taxable_Country Take from first tax block 

UniqueName Tax.Erp_Tax_Code 

Take from first tax block. Left 2 
digits, will map right 3 digits to 
Account Key field once field added 
by Ariba 

custom <Collection> 

CustomBoolean Line.User_Element.Value 

CustomInteger Line.User_Element.Value 

CustomMoney <Collection> 

Amount Line.User_Element.Attribute42 
AmountInReporting 

Currency Line.User_Element.Attribute43 
ApproxAmountInBas 

eCurrency Line.User_Element.Attribute44 

ConversionDate Line.User_Element.Attribute45 

Currency <Collection> 

UniqueName 
Line.User_Element.Attribute4 

6 

CustomString Line.User_Element.Value 

UniqueName Invoice.Invoice_Number 

custom <Collection> 

CustomBoolean Line.User_Element.Attribute 

CustomInteger Line.User_Element.Attribute 

CustomMoney <Collection> 

Amount Invoice.User_Element.Attribute42 

AmountInReportingCurrency Invoice.User_Element.Attribute43 
ApproxAmountInBaseCurren 

cy Invoice.User_Element.Attribute44 

ConversionDate Invoice.User_Element.Attribute45 

Currency <Collection> 

UniqueName Invoice.User_Element.Attribute46 

CustomString Invoice.User_Element.Attribute 
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APPENDIX II 

SAP ARIBA REPORTS WITH TAX DATA 
SAP Procurement Solution offers reporting functionality to analyze the transaction data. The two options 
“Pre-packaged reports” and “Analytical report” provide users opportunity to extract the transaction data for 
different analysis purpose.   

User can use prepackaged reports and modify them for desired reporting data or may use Analytical 
Reports option to create completely customized reports. Here we show sample prepackaged reports with 
a little modification (Invoice Report modified) to show tax calculated by ONESOURCE Global Tax for SAP 
Ariba Solutions.   

Tax Data generated on approvable documents during procurement transactions can also be seen on 
standard reports. And reports can be customized by adding report fields required from available report 
field inventory or deleting fields which are not necessary per user’s requirement. 

REQUISITION REPORT WITH TAX DATA 
Tax data generated during Requisition transaction processing can be seen on report “Requisition Spend 
with Charges and Taxes” available in Pre-packaged reports. 

Navigation for accessing the Requisition Spend with Charges and Taxes report: 

1. Log in SAP ARIBA Procurement Solution 

2. On Home screen navigate to > Manage > Prepackaged Reports 

3. System would display list of available Prepackaged Reports. Under the Name Column > 
Click on Requisition Reports > Click on Open on pull down menu 

4. System would display all reports related to Requisition reporting 

5. Click on Requisition Spend with Charges and Taxes > Click on Open on the pull down menu 

6. System would display the report as shown in below screenshot   

User can use standard edit and export and other functionalities to modify the report. Reporting feature 
description is beyond the scope of this document. Please refer SAP ARIBA product documentation to 
learn more about working with Reports. 
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To display tax data at authority level: Click on Report Column Line Type > Select Line Type (all) option on 
the pull down menu. 

Reporting Requisition Spend with Charges and Taxes Edit Save... Export Actions

Field Browser
Pivot table Chart  Dashboard

Page Others

Applied Filters

2,319.64 Requisition DateSpanning: most recent 2 Year(s) Display Options Edit

Line Type Min/Max rows: 3/8
*Exclude * Charge, Tax, Discount

Detail View

Requisition Line  Requisition RequisitionDiscount Charge
 Requisition RequisitionLine ERP TypeUnit of QuantityUnit PriceAmountAmountTa
ID Date  Number Supplier  Part Name  DescriptionCommodity Measure + (USD) (USD) (USD) (U

Total 2,319.64 639.25 -723.75 504.00

IL Office(3001_IT
PR170 - 1/13/2017 Cafeteria CatalogSupplies Consultation 3001)Consultation hourItem 1,000.00 15.00 0.00 0.00

State Sales/Use - services

IL Office12/14/2016 (3001_IT Organizational
PR52- Supplies Consultation 3001)Consultation Catalogstructure hour 160.00Item 100.00 0.00 0.00

State Sales/Use consultation
IL Office1/13/2017 Cafeteria Non-

PR172- SuppliesUnclassified - Service Req3 Catalog each 100.00 15.00 0.00 0.00
services

Detail View

Line Requisition  Requisition DiscountCharge
ERP TypeUnit of QuantityUnit PriceAmountAmountTax AmountGross Amount
Supplier  Part Name Description Commodity Measure + (USD) (USD) (USD) (USD) (USD)

2,319.64 639.25 -723.75 504.00 152,191.151,635,241.21
IL Office (3001_IT Cafeteria Catalog hour SuppliesConsultation 3001)Consultation services Item 1,000.00 15.00 0.00 0.00 1,275.00 16,275.00

State Sales/Use -
IL Office (3001_IT Organizational
 Supplies CatalogConsultation 3001)Consultation structure Item hour 160.00 100.00 0.00 0.00 0.00 16,000.00

State Sales/Use - consultation
IL Office Cafeteria Non-
Supplies Unclassified - Service Req3 Catalog each 100.00 15.00 0.00 0.00 127.50 1,627.50services Item
IL Office Printer and

facsimile andNon-
 SuppliesUnclassified - Tax Test Catalog each 100.00 10.00 0.00 0.00 0.00 1,000.00photocopier Itemsupplies

IL Office Printer and
facsimile and Non-

 SuppliesUnclassified - Tax Test Catalog each 100.00 10.00 0.00 0.00photocopier 0.00 1,000.00
supplies Item

IL Office (3001_PrintSupplies Printer and

 Supplies3001) State facsimile andCatalogPrint Supplies each 100.00 100.00 0.00 0.00 825.00photocopierItem 10,825.00
Sales/Use - supplies

IL Office (3001_PhotoCopier2

 Supplies3001) Multi-PurposePhoto Copier2 PhotocopiersCatalog
Photocopier- Item each 90.00 3,000.00 0.00 0.00 22,275.00 292,275.00
200400A
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Detail View

quisition Line RequisitionRequisitionDiscountCharge
e ERP Type Unit of Quantity Unit PriceAmount Amount Tax Amount Gross Amount
mber Supplier  Part Name Description Commodity Measure (USD) (USD) (USD) (USD) (USD)

2,319.64 639.25 -723.75 504.00- 152,191.15 1,635,241.21

IL Office (3001_IT
Supplies Consultation 3001) Cafeteria CatalogConsultation hour 1,000.00 15.00Item

0.00 0.00 1,275.00 16,275.00
State Sales/Use services

IL Office (3001_IT Organizational
Supplies Consultation 3001) CatalogConsultation structure hour 160.00 100.00 0.00 0.00 0.00Item 16,000.00

State Sales/Use consultation
IL Office Cafeteria Non-
Supplies Unclassified- Service Req3 Catalog each 100.00 15.00 0.00 0.00 127.50 1,627.50

services Item
IL Office Printer and

facsimile and Non-
SuppliesUnclassified Tax Test Catalog each 100.00 10.00 0.00 0.00 0.00 1,000.00photocopier

supplies Item

IL Office Printer and Non-
Supplies Unclassified Tax Test facsimile and Catalog each 100.00 10.00 0.00 0.00 0.00 1,000.00photocopier Itemsupplies

Expand Next Level Detail View

quisition At lowest level RequisitionDiscount Charge
e ERP Unit PriceAmount AmountTax Amount Gross Amount
mber Supplier Part Name Description Commodity Select Level, Values: (USD) (USD) (USD) (USD) (USD)

Line Type (all)
639.25 -723.75 504.00- 152,191.15 1,635,241.21

IL Office (3001_IT
Supplies Consultation 3001)Consultation Cafeteria Catalog ltem 15.00 0.00 0.00 1,275.00 16,275.00

State Sales/Use services

IL Office (3001_IT Organizational Non-Catalog Item
Supplies Consultation 3001)Consultationstructure Select Others. 100.00 0.00 0.00 0.00 16,000.00

State Sales/Use consultation
IL Office Cafeteria Select Search Filter..
Supplies Unclassified - Service Req3 15.00 0.00 0.00 127.50 1,627.50services

Move Field
IL Office Printer and

SuppliesUnclassified - Tax Test facsimile and
Left 10.00

photocopier 0.00 0.00 0.00 1,000.00

supplies Right
IL Office Printer and

Supplies Unclassified Tax Test facsimile and
Show Field On 10.00 0.00 0.00 0.00photocopier 1,000.00

supplies
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Report can be exported to user’s system. SAP ARIBA solution exports the data in pivot table. 

1. Click on Export button 

2. System would process export in 6 automatic steps as shown in below screenshot. Once 

completed, an Excel file will be opened on User’s computer system with report data 

Detail View

juisition Requisition RequisitionDiscount Charge
ERP Line Unit of QuantityUnit PriceAmountAmountTax AmountGre ss Amount

nber  SupplierPart Name DescriptionCommodity Type Measure + (USD) (USD) (USD) (USD) (US D)
2,319.64 639.25 -723.75 504.00 303,807.55 1,938,325.01

IL Office (3001_IT
 SuppliesConsultation 3001) ConsultationCafeteria Catalog

Item hour 1,000.00 15.00 0.00 0.00
services 1,275.00 16,275.00

State Sales/Use
IL Office (3001_IT

001-  SuppliesConsultation 3001)State Cafeteria
Sales/Use Tax hour 0.00 0.00 0.00 900.00 1,800.00

State Sales/Use services

IL Office (3001_IT
002 - SuppliesConsultation 3001)District Cafeteria

Sales/Use x1 hour 0.00 0.00 0.00 187.50 375.00
State Sales/Use services

IL Office (3001_IT
103-  Supplies CityConsultation 3001) Cafeteria Tax hour 0.00 0.00Sales/Use 0.00 187.50 375.00

State Sales/Use services

IL Office (3001_IT Organizational
 SuppliesConsultation 3001)Consultation Catalogstructure Item hour 160.00 100.00 0.00 0.00 0.00 16,000.00

State Sales/Use consultation
IL Office

Cafeteria Non-
 SuppliesUnclassified Service Req3 Catalogeach 100.00 15.00 0.00 0.00 127.50 1,627.50services Item
IL Office

001 - Supplies Unclassified State Cafeteria TaxSales/Use each 0.00 0.00 0.00 90.00 180.00services

IL Office
002-  SuppliesUnclassified District Cafeteria

Sales/Use Tax each 0.00 0.00 0.00 18.75services 37.50

>

ExportingtoExcel template Return to Report

Your data is being exported. If you are asked to enable ActiveX, respond Yes. Otherwise, your data cannot be exported to Excel.

1. Contacting Excel

2.Downloadingtemplate

3. Waiting for query
4.Downloadingdata

5. Configuring layout
6. Done

Return to Report

  

 

     
     

           

      
  

     
      

 
  

 
  

    
        

  

  
    

        
  

  
             

  

   
             

 
 

  
          

 
 

     
         

 
    

         

  

 

 

 
 

 

 
 



Appendix II 63 

SAP Ariba Reports With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

PURCHASE ORDER REPORT WITH TAX DATA 
In SAP ARIBA Procurement Solution, once PR is approved, Purchase Order is generated. The tax 
calculated on PR will be copied over to Purchase Oder document. The tax amount, tax authority data 
received from ONESOURCE Global Tax for SAP Ariba Solutions would be similar to the data found on 
Purchase Requisition. But the report Purchase Order Spend with Charges and Taxes would show tax on 
Purchase Order. 

Navigation for accessing the Purchase Order Spend with Charges and Taxes: 

1. Log in SAP ARIBA Procurement Solution 

2. On Home screen navigate to > Manage > Prepackaged Reports 

3. System would display list of available Prepackaged Reports. Under the Name Column > 
Click on Purchase Order Reports > Click on Open on pull down menu 

4. System would display all reports related to Purchase Order reporting 

5. Click on Purchase Order Spend with Charges and Taxes > Click on Open on the pull down 

menu 

B C D E
Re Total

2 This Worksheet Will ContainDataPopulated From AribaSpend Management.
3 Requisition Quantity Requisition Unit PriceDiscount Amount (USD)Charge Amount (USD)Tax Amount (USD)
4 ToQuery Parameters: Range"Ariba Data Params"
5 Source Data Requisition

Fixed_Columns FALSE

6
7 Query_Filters
8 Field Mappings
6 RawFieldNames Requisitionld,RequisitionDate.Day,RequisitionLineNumber, Supplier. SupplierName, Part.PartName,Description, Commodity.Com.
10 Sort Fields
11
12 Data Table: Range"Ariba_Data"
13
14 Requisition ID Requisitioning DateRequisition Line NumberSupplier - ERP SupplierPart - Part Name
15 PR713 5/12/2017 100002 Office Products GB (2001_9X-Propane 2001) VAT
16 PR720 5/14/20171 Ofice Products GB (2001_9X-Propane 2001) VAT
17 PR743 5/18/20171 Ofice Products GB (2001_9X-Propane 2001) VAT
18 PR728 5/16/20171 Ofice Products GB (2001_9X-Propane 2001) VAT
19 PR747 5/18/20171 Ofice Products GB (2001_9X-Propane 2001) VAT
20 PR696 5/9/20171 Office Products GB Unclassified
21 PR713 5/12/20171 Ofice Products GB (2001_9X-Propane 2001) VAT
22 PR745 5/18/20171 Ofice Products GB (2001_9X-Propane 2001) VAT
23 PR753 5/18/20171 Office Products GB (2001_9X-Propane 2001)VAT
24 PR697 5/10/20171 Office Products GB (2001_Propane 2001) VAT
25 PR800 5/31/20171 Ofice Products GB (UK2001LMS-LANMaintenanceSupport2001)
26 PR710 5/12/2017 2 IL Office Supplies (3001_InkCatridge 3001) State Sales/Use
27 DD712 5/12/20172 IOffca Cunnliar /3nn1InlCatridao3nn11CtataCalac/llca

    
 

  
     
  
   

  

 
  
  
  
  
 
  
 
    
     
     
     
     
     
     
     
     
     
     
     
     

    



64 Appendix II 

SAP Ariba Reports With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

6. System would display the report.

7. To display tax data at authority level > Click on Report Column Line Type > Select Line Type
(all) option on the pull down menu

Purchase Order Reports Show Detailed View

Purchase Order Reports Show Details Actions A

Name Owner

PCard Order Details aribasystem

Purchase Order Activity aribasystem

Purchase Order Spend with Charges and Taxes aribasystem

Purchase Order Spend with Charges and Taxes Detail aribasystem

ÿ Purchase Price Variance by Commodity aribasystem

ÿ Received Not Invoiced Report aribasystem

ÿ Requisition Total by Supplier - aribasystem

ÿ  Spend Concentration Analysis by Commodity aribasystem

ÿ Spend Penetration by Commodity aribasystem

Top items ordered by Punchout vs. Contained - aribasystem

ÿ Total number of items ordered aribasystem

Reporting Purchase Order Spend with Charges and Taxes 11P3 Save. Export Actions

Field Browser
Pivot table Chart Dashboard

Page Others

Applied Filters

2,078.82 Ordered DateSpanning: most recent 2 Year(s) Display Options Edit

Line Type Min/Max rows: 3/8*Exclude * Charge, Tax, Discount

Detail View

Line PO PO Unit Discount Charge
Order Ordered PO LineType ERP Unit of QuantityPrice PO SpendAmountAmount

 RequesterId Date  Number Description Supplier  Measure+ (USD) (USD) (USD) (USD)

Total 2,078.82 569.7593 1,184,643.75 -713.75 234.81

Venu KotagiriPO68 1/13/2017 Catalog Consultation IL Office
Item Supplies hour 1,000.00 15.0000 15,000.00 0.00 0.00

PO22 12/14/2016 CatalogConsultation IL Office
Item hourSupplies 160.00 100.0000 16,000.00 0.00 0.00

PO16 12/9/2016 Non-
Catalogg Tax Test- IL Office

Supplieseach 100.00 10.0000 1,000.00 0.00 0.00
Item 

PO31 12/18/2016 Catalog Print Supplies TIL Office
Item Sunnlies each 100.00 100.0000 10,000.00 0.00 0.00

Detail View

Line PO PO Unit Discount Charge
Order Ordered PO Line Type ERP Unit of Quantity Price PO Spend Amount Amount

Requester Id Date Number Description Supplier Measure + (USD) (USD) (USD) (USD)

Total 2,078.82 569.7593 1,184,643.75 -713.75 234.81

VenuKotagiri PO68 1/13/2017 CatalogConsultation IL Office
Item Supplies hour 1,000.00 15.0000 15,000.00 0.00 0.00

PO22 12/14/2016 CatalogConsultation IL Office
Item Supplies hour 160.00 100.0000 16,000.00 0.00 0.00

PO16 12/9/2016 Non-
CatalogTax Test IL Office

Supplies each 100.00 10.0000 1,000.00 0.00 0.00
Item 

PO31 12/18/2016 CatalogPrint Supplies IL Office
Item Supplies

each 100.00 100.0000 10,000.00 0.00 0.00

PO36 12/19/2016 CatalogPhoto Copier2 IL Office
Item Supplies each 90.00 3,000.0000 270,000.00 0.00 0.00

  

 

  

  

    

  

  

 

 

  

   

   

   

  

   

  

  

      

 
   

  

 

    
 

  

 

     
       

         

      
     

 
      

      
     

     
 

      

    
 
      

 

     
           

            

      

     
 

      

     
 

      

  
   

 
      

    
 

 
      

     
      



Appendix II 65 

SAP Ariba Reports With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

Line Type with Description column showing tax data by tax authority level 

Report can be exported to user’s system. SAP ARIBA solution exports the data in pivot table (export file 

type can be configured. The option to do so is available under > Actions > Configure Export). 

1. Click on Export button 

2. System would process export in 6 automatic steps as shown in below screenshot. Once 

completed, an Excel file will be opened on User’s computer system with report data 

Pivot table Chart Dashboard Expand Next Level

At lowest level

Applied Filters
Select Level, Values:

2,078.82 Ordered Date Spanning: most re Display Options Edit

Line Type Line Type (all) Min/Maxrows:3/8
*Exclude * Charg

Catalog Item

Non-Catalog Item Detail View

Select Others..
PO PO Unit Discount Charge

Order Ordered PO Line T Select Search Filter.. ERP Unit of Quantity Price PO Spend Amount Amount
RequesterPI Date Number Supplier Measure + (USD) (USD) (USD) (USD)

Move Field
Total 2,078.82 569.7593 1,184,643.75 -713.75 234.81

Venu Kotagiri PO68 1/13/2017 C Left IL Office
It Supplies hour 1,000.00 15.0000 15,000.00 0.00 0.00

PO22 12/14/2016 C Right IL Office
It hourSupplies 160.00 100.0000 16,000.00 0.00 0.00

Detail View

PO PO Unit DiscountCharge
Line ERP Unit of Quantity Price PO Spend Amount AmountTax AmountGross AmountNumber
Type Description Supplier Measure + (USD) (USD) (USD) (USD) (USD) (USD) Accepted

2,078.82 569.7593 1,294,869.92-713.75 234.81- 222,454.58 1,516,845.56 650.00

CatalogConsultation IL Office
Item Supplies hour 1,000.00 15.0000 15,000.00 0.00 0.00 1,275.00 16,275.00 0.00

xe1 State Sales/Use IL Office
Supplieshour 0.00 900.00 0.00 0.00 900.00 1,800.00 0.00

Tax - District Sales/Use - IL Office
 Supplieshour 0.00 187.50 0.00 0.00 187.50 375.00 0.00

TaxT City Sales/Use - IL Office
Supplieshour 0.00 187.50 0.00 0.00 187.50 375.00 0.00

CatalogConsultation IL Office
Item Supplieshour 160.00 100.0000 16,000.00 0.00 0.00 0.00 16,000.00 160.00
Non-
CatalogTax Test - IL Office

Supplies each 100.00 10.0000 1,000.00 0.00 0.00 0.00 1,000.00 50.00
Item
CatalogPrint Supplies IL Office
Item Supplieseach 100.00 100.0000 10,000.00 0.00 0.00 825.00 10,825.00 1.00

Tax State Sales/Use IL Office
Supplieseach 0.00 625.00 0.00 0.00 625.00 1,250.00 0.00

City Sales/Use - IL Office
Supplieseach 0.00 100.00 0.00 0.00 100.00 200.00 0.00

Tax T District Sales/Use - IL Office
Supplieseach 0.00 100.00 0.00 0.00 100.00 200.00 0.00

CatalogPhoto Copier2 IL Office
Item Supplies each 90.00 3,000.0000 270,000.00 0.00 0.00 22,275.00 292,275.00 13.00

    

 

 
 

    

   
 

 

  

 
    

   
        

           
 

      

     
        

     
   

    

 

   
        
            

      
  

           

  
         

   
         

   
         

  
          

   
          

 
  

  
         

  
 

        

  
 

        

   
 

        
  

          



66 Appendix II 

SAP Ariba Reports With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

INVOICE REPORT WITH TAX DATA 
Tax data is captured on Invoice approvable during transaction processing. SAP ARIBA Procurement 
solution provides reports on Invoice spend with tax data. 

Navigation for accessing Invoice report with tax data: 

1. Log in to SAP ARIBA Procurement Solution 

2. Navigate to Manage > Prepackaged Reports > Buyer Settlement Reports > Click on Open on 

the pull down menu 

3. System would display all reports related to Invoice 

4. Click on report Invoice spend with charges and taxes details > Click on Open on the pull 

down menu 

5. System would display Invoice spend with charges and taxes details report 

ExportingtoExcel template Return to Report

Your data is being exported. If you are asked to enable ActiveX, respond Yes. Otherwise, your data cannot be exported to Excel.

1. Contacting Excel

2.Downloadingtemplate

3. Waiting for query
4.Downloadingdata

5. Configuring layout
6. Done

Return to Report

A B C D E G
PCTotal

2 ThisWorksheetWill ContainDataPopulated FromAribaSpend Management.
3 PO Quantity PO Unit Pri PO Spend (US[Discount Amount (Charge Amount (UTax Amount (USD) Gross Amot
4 ToQueryParameters:Range"AribaDataParams"
5 Source Data Purchase Order(Procurement & Invoicing)

Fixed_Columns FALSE

6
7 Query_Filters
8 Field Mappings
6 RawFieldNames RequesterUserName,OrderD,OrderedDate.Day,POLineNumber,LineType,Description,SupplierSupplierName,UnitOfMasure.
10 Sort Fields
11
12 DataTable:Range"Ariba_Data*
13
14 Requester Order Id OrderedDatePOLineNumberLineTypeDescription Supplier -
15 Rob Montanez PO243 5/23/20171 Catalog IltemOficeProDesktopComputer Office Produ
16 George Compton PO259 6/8/20171 Catalog Item Photocopier-3001PCS IL Office Su
17 Venu Kotagiri PO108 3/15/2017 2 Catalog ItemIT EquipmentService IL Office Su
18 Venu Kotagiri PO51 1/10/20171 Catalog ltem Photo Copier2 IL Ofice Su
19 Venu Kotagiri PO30 12/18/20161 Non-Catalog ItemIR failure test 12/18 IL Office Su
20 Venu Kotagiri PO38 12/22/20161 Catalog ltem Photo Copier2 IL Office Su
21 Venu Kotagiri PO134 3/23/20171 Catalog ltem Multi-Purpose Photocopier-3001PCAIL Office Su
22 Venu Kotagiri P0104 3/9/20171 Catalog ItemPhotocopier-3001PCS IL Office Su
23 Venu Kotagiri PO24 12/15/20161 Catalog ItemPhoto Copier2 IL Office Su
24 Venu Kotagiri PO172 4/18/20171 Catalog ltem 3001PCAlnkCatridge IL Office Su
25 Venu Kotagiri PO165 4/18/20171 Non-Catalog Itemdemo non catalog Office Produ
26 Venu Kotagirni PO18 12/13/20161 Catalog Item Photo Copier2 IL Office Su

  

  

 

 

 
 

 

 
 

      
 

  
    
  
   

  

 
  
  
  
  
 
  
 
      
      
       
       
       
       
       
       
      
       
       
       
      



Appendix II 67 

SAP Ariba Reports With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

The standard report shows tax relevant reportingd fields like Tax Code ID, Tax Code Description, Tax 

Amount and Tax Authority (Line Type) but to analyze tax exceptions and tax accrual data, user can add 

more required fields by following below steps: 

1. Click on Edit button (top, right side of the page) 

2. User would be presented with Edit UI > Click on Source Data 

Reporting Invoice Spend with Charges and Taxes Edit Save.. Actions

Field Browser
Pivot table Chart Dashboard

Page Others

Applied Filters 
728.82 Accounting DateSpanning: most recent 2 Year(s) Display Options Edit

Line Type Min/Max rows:3/8
Catalog Item 

Detail View

Invoice Line
ERP AccountingLine Type Unit of Tax Code Tax C
Supplier Invoice ID Date Number Part Name Description CommodityMeasureName Id 

Total
IL Office IRservice test PO22/RC25-12/14/2016 Catalog(3001_IT Consultation Organizational
Supplies 29- Item - 3001) State Sales/UseConsultation structure hour Unclassified Uncl:

consultation
Printer and IDT

IRIRFailureTest2_12/18-4712/18/2016 Catalog(3001_PrintSupplies 3001) Print Suppliesfacsimile andeach Fallback
Item State Sales/Use photocopier Self AccrualZZ

supplies Input Tax
(3001_IT Information IDT

RI79 test.152 2/11/2017 Catalo Eallh

Invoice Spend with Charges and Taxes Edit Save. Export Actions

Pivot table Chart Dashboard

Applied Filters

728.82 Accounting DateSpanning: most recent 2 Year(s) Display Options Edit

Line Type
Min/Max rows:3/8

Catalog Item

Detail View

Invoice Line
ERP AccountingLine Type Unit of Tax Code Tax Co
Supplier Invoice ID Date Number Part Name Description CommodityMeasure Name Id

Total

IL Office IRservice test PO22/RC25-12/14/2016 Catalog (3001_IT Consultation Organizational
Supplies29- Item - 3001) State Sales/Use Consultation structure hour Unclassified Uncl:

consultation

    

 
   

  

    
 

 

 

 
      

        

 
      
       

 
  

    
 

   
   

 

  
   

    

     

   

 

    

 
 

 

 

  
       

         

 
     
        



68 Appendix II 

SAP Ariba Reports With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

3. Source Data UI presented with options to edit source data 

4. Available Measures section gets updated with Purchase Order related fields 

Edit Analysis Invoice Spend with Charges and Taxes Previous Done Save

Filter the data in your report by selecting values for the fields below. Allreports include a date field flter. To select a different date field to use as a filter, select Advanced Options. For More

Accounting Date (Calendar): * O Relative date range
Source Data

Time period:Year(s)

Pivot Layout Most recent2 time periods

Future time periods
Refine Data

OFixeddaterangefrom:4/1/2017 6/30/2017 ÿ

Advanced Options

Line Type:Catalog Item

Customize this form

Show Report Query

Edit Analysis InvoiceSpendwithChargesandTaxes Next Done

Enter a title for your report select a data source to investigate from the Main Fact pull-down menu, and add at least one data field to the Data area of the pivot layout. To create a multi-Mor

Title: InvoiceSpendwithChargesand Taxes
Source Data

DescnpbonInvoice Spend with Charges and Taxes

Pivot Layout

Ropart CurroncyUserPreference
Refne Data

DataSources

Main Fact Invoice

Second Fact (None selected) 0

Third Fact: (None selected)

Avallable Measures Page Fields

Pre-defined

Measuresin Onginal Currency
ColumnFields

Slandard Calculabons

Age(Days)- RowFlelds
ERP Suppler Data

Amounit Accepted (USD) InvoiceID Invoice Quantty
Accounting Date

Amount Disputed (USD) Line Type
Invoice Line NumberInvoice Unit Price(USDÿ

Amount Invoiced (USD) Ioice Spend (USD)

Discount Amount(USD)
Create User-defined Feld Chargo Amount (USD)

Tax Amount(USD)

Dutail Fiekis
PartName
Description
Commodity
Unit of Measure
Tax Code Name
TaxCodeld
Tax CodeDescription
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SAP Ariba Reports With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

5. Click on Purchase Order pull down menu > Select Tax Amount > Click on Add to Report   

  

AvailableMeasures AlIl
Page Fields

Line Count -

Paid Amount (USD) Column Fields

Split Count 

Sum of Paid Payment Row Fields Data
ERP Supplier
Invoice ID [INV] Invoice Quantity

Tax Accrual Amount (USD) Accounting Date
Invoice Line Number

Purchase Order
[INV] Invoice Unit Price (USD)

Line Type

User-defined [INV] Invoice Spend (USD)

Create User-defined Field [INV] Discount Amount (USD)

Available Measures All
Page Fields

Price Variance Cost (USD) 

Serviced Amount Approved (USD) Column Fields

Serviced Amount in Approval (USD) 

Split Count Row Fields
ERP Supplier

 Data

Invoice ID [INV] Invoice QuantityTax Amount (US[
Action Accounting Date

Invoice Line Number[INV] Invoice Unit Price (USD)
Tax Amount Invoi Line TypeAdd to Report
User-detined [INV] Invoice Spend (USD)

Create User-defined Field [INV] Discount Amount (USD)

[INV] Charge Amount (USD)

[INV] Tax Amount (USD)

Detail Fields
Part Name
Description
Commodity
Unit of Measure
Tax Code Name

  
 

 

  

   
 

    
 

 
 

 

  

 

  
 

  

 
 

 

   
  

     

  

  

 

 

 
 
 
 

 



70 Appendix II 

SAP Ariba Reports With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

6. Select next field Tax Amount Invoiced > Click Add to Report 

7. Scroll up > Click on Invoice pull down option > Select Amount Accepted, Amount Disputed,     

and Amount Invoiced fields (click on field, then click on Add to Report; repeat for each field). 

  

Available Measures All
Page Fields

Price Variance Cost (USD) 

Serviced Amount Approved (USD) Column Fields

Serviced Amount in Approval (USD) 

Split Count Row Fields
ERP Supplier

 Data

Invoice ID [INV] Invoice QuantityTax Amount (US[
Action Accounting Date

Invoice Line Number[INV] Invoice Unit Price (USD)
Tax Amount Invoi Line TypeAdd to Report
User-detined [INV] Invoice Spend (USD)

Create User-defined Field [INV] Discount Amount (USD)

[INV] Charge Amount (USD)

[INV] Tax Amount (USD)

Detail Fields
Part Name
Description
Commodity
Unit of Measure
Tax Code Name

AvailableMeasures AlIl

Invoice

Measures in Original Currency

Standard Calculations

Age (Days)

Amount Accepted (USD)

Amount Disputed (USD)

Amount Invoiced (USD)

Create User-defined Field

  

  
 

  

 
 

 

   
  

     

  

  

 

 

 
 
 
 

 

  

 

 

 

 

 

 

 



Appendix II 71 

SAP Ariba Reports With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

8. Add Tax Accrual Amount field (Click on the field > click on Add to Report option on pull 

down menu). 

9. The fields user selected all are added to report structure. 

10. To change the positioning of the fields on report display, click on the field pull down arrow > 

select either move up and move down option to create desired order of the fields 

AvailableMeasures All
Page Fields

Line Count

Paid Amount (USD)-

Split Count -
Column Fields

Sum of Paid Payment
Row Fields Data

Tax Accrual Amount (USD [INV] ERP Supplier
Action [INV] Invoice ID [INV] Invoice Quantity

[INV] Accounting Date
Purchase Order

Add to Report [INV] Invoice Line Number[INV] Invoice Unit Price (USD)
[INV] Line Type

Measures in Original Currency

[INV] Invoice Spend (USD)
Amount Acrantad in Oriainal Currone

Create User-defined Field [INV] Discount Amount (USD)

[INV] Charge Amount (USD)

[INV] Tax Amount (USD)

[PO] Tax Amount (USD)

Measures in Original Currency
Column Fields

Standard Calculations

Age (Days)- Row Fields
[INV] ERP Supplier Data

Expected Tax Amount (USD) [INV] Invoice ID [INV] Invoice Quantity
[INV] Accounting Date

Invoice Count [INV] Invoice Line Number[INV] Invoice Unit Price (USD)
[INV] Line Type

Line Count -
[INV] Invoice Spend (USD)

Create User-defined Field [INV] Discount Amount (USD)

[INV] Charge Amount (USD)

[INV] Tax Amount (USD)

[PO] Tax Amount (USD)

[PO] Tax Amount Invoiced
(USD)

[INV] Amount Invoiced (USD)

[INV] Amount Accepted (USD)

[INV] Amount Disputed (USD)

  
 

 

 

 
 

  
 

  
   

  
   

 
 

 
 

  

 

 

 
 

 

  
 

 

   
 

  
 

 
 

  

 

 

 

 
 

 

 



72 Appendix II 

SAP Ariba Reports With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

11. Once desired editing is completed, click on Done button. 

  

[INV] Tax Amount (USD)

[PO] Tax Amount (USD)

[PO] Tax Amount Invoiced
(USD)

[INV] Amount Invoiced (USD)

IINMA Amount Aecontod (USD)
Action

(USD)
Remove

Move Up

Move Down

Edit.

[INV] Tax Code Name
[INV] Tax Code Id
[INV] Tax Code Description

EditAnalysis InvoiceSpendwithChargesandTaxes Next Done

Enter a title for your report, select a data source to investigate from the Main Fact pull-down menu, and add at least one data field to the Data area of the pivot layout.To create a multi-More

Title: * InvoiceSpendwithCharges and Taxes
Source Data

Description: InvoiceSpend with Charges and Taxes

Pivot Layout

Report Currency:User Preference

3 Refine Data
Data Sources
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SAP Ariba Reports With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

12. System would display the report. 

13. Click on Line Type > Select Line Type (All) option. (This can be also done on Source Data UI   

Page > Line Type pull down menu). 

Reporting Invoice Spend with Charges and Taxes 1P3 Save.. Actions

 Field Browser
 Pivot table Chart  Dashboard

Page Others

Applied Filters

Accounting DateSpanning: 4/1/2017 -- 6/30/2017 Display Options Edit
Min/Max rows: 3/8

[INV] Line TypeCatalog Item

Detail View 

[INV] [INV] [INV] [INV 
[INV] invoice Line [INV] Unit Tax Tax [IN

[INV] ERP AccountingLine Type [INM] of Code Code Cc
Supplier[INV] Invoice ID Date Number [INV] Part Name [INV] Description CommodityMeasure Name Id De

Total 
IDT

DE SpareIRRecal.Tax-365 - 4/19/2017 Catalog (3013_Photocopier 3013)Photo Copier Photocopierseach Standard
Parts Item Photo Copier  1ndnoA1

TAX
IDT

ERS IRlnv-CR10-394 - 4/21/2017 Catalog(3010 3010) TestCR1 TestCR1 Ink cartridgeseach fallback
vendor - Item 1ndino XX

tax

Information IDT
AN612017 Standard

Invoice Spend with Charges and Taxes Edit Save.. Export Actions

Pivot table Chart Dashboard

Applied Filters

Accounting Date Spanning: 4/1/2017 -- 6/30/2017 Display Options Edit
Min/Max rows:3/8

[INV] Line TypeCatalog Item

Detail View

[INV] [INV] [INV] [INV] 
[INM] Invoice Line [INV] Unit Tax Tax [IN

[INV] ERP AccountingLine Type [INV] Code CodeCc
Supplier [INV] Invoice ID Date Number [INV] Part Name [INV] Description Commodity Measure Name Id De

Total
IDT

DE SpareIRRecal.Tax-365 4/19/2017 Catalog (3013_Photocopier 3013)Photo Copier Photocopiers Standard
Parts Item - Photo Copier each indino A1

TAX

     

 
  

  

 

   
 

  

     
         

         

 
         

  
 

 
 

         
  

 

 

  
 

    

   

 

   
 

  

 

 
       

       
           

 

 
    

   
      



74 Appendix II 

SAP Ariba Reports With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

14. Move columns left or right, scroll left or right to check the data. Line Type and Description 

fields show the authority level tax information. Scroll right to check relevant Tax amounts. 

Invoice Spend with Charges and Taxes Edit Save... Export Actions

Expand Next Level
Pivot table Chart Dashboard

At lowest level

Applied Filters Select Level, Values:

Accounting DateSpanning: 4/1/2017 -- 6/30/2017 Display Options Edit
[INV] Line Type (all)

Catalog Item
Min/Max rows:3/8

[INV] Line Type
Catalog lItem

Select Others..
Detail ViewSelect Search Filter..

[INV] Move Field [INV] [INM]
[INV] Invoice [INV] Unit x1 [IN

[INV] ERP AccountingLine Left [INV] of Code Code Cc
Supplier [INV] Invoice ID Date Number [INV] Description CommodityMeasure Name Id De

Right
Total

[INV] [INV] 
Invoice [INV] [INV] Unit [INV] Tax [INV] Tax invoice [INV] Invoice
Line Line [INV] of Code [INV] Tax Code QuantityUnit Price
Number Type [INV] Description [INV] Part Name Commodity Measure Name Code Id Description+ (USD)

State Sales or use taxes
Sales/Uselevied by a state (auto-Unclassified Ink cartridgesUnclassifiedIDT fallbackXX Unclassified 0.00

generated) - output tax

County Sales or use taxes
Sales/Uselevied by a county Unclassified Ink cartridgesUnclassifiedIDT fallbackXX Unclassifiedoutput tax 0.00

(auto-generated)
Information IDT

CatalogMilestone Test - (UELC_3010 3010) Statetechnologyhour
Standard

Item Sales/Use Output TAXAD Unclassified 1.00 100.0000consultation
services Exempt

State Sales or use taxes Information IDT
technologySales/Uselevied by a state (auto-Unclassified UnclassifiedStandard

Output TAXAO Unclassified 0.00
generated)- consultation

services Exempt
County Sales or use taxes Information IDT
Sales/Uselevied by a countyUnclassified technologyUnclassifiedStandard

Output TAXAO Unclassified 0.00
(auto-generated) consultation

services Exempt
Catalog IDT

Item TestCR1 - (3010 3010) TestCR1 Ink cartridgeseach Standard A1 Unclassified 1.00 25.0000
Output TAX

State Sales or use taxes IDT
Sales/Uselevied by a state - lineUnclassified Ink cartridgeseach Standard A1 Unclassified 0.00

level - Output TAX
City Sales or use taxes IDT

3 Sales/Use levied by a city - lineUnclassified Ink cartridgeseach Standard A1 Unclassified 0.00
<

  

     

 
   

 

  

    
 

 
 

 

 
  

    
    

         
         

 

 
      

        
         

  
  

         
  

  
          

 
  

     
 

      
 

  
    

     
 
   

  
  

    
      

    
  

  
 

 
         

 
   

        
  

   
         



Appendix II 75 

SAP Ariba Reports With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

15. To work on this data in an excel file > Click on Export (Export function has options to choose 

file type and other download and display options which is beyond the scope of this 

document). 

16. System would perform 6 steps to prepare and download data in to excel file. 

[INV] [INV] [INV [PO] Tax [INV] [INV] [INV] [INV] Tax
[INV] Tax invoice [INV] Invoice [INV] InvoiceDiscountCharge[PO] Tax [INV] Tax Amount Amount Amount Amount Accrual
Code QuantityUnit Price Spend Amount AmountAmount Amount Invoiced Invoiced Accepted Disputed Amount
Description + (USD) (USD) (USD) (USD) (USD) (USD) (USD) (USD) (USD) (USD) (USD)

Unclassified 0.00 1.50 0.00 0.00 2.13 1.50 2.13 0.25 1.50 -1.25 1.25

Unclassified 0.00 0.31 0.00 0.00 2.13 0.31 2.13 0.25 0.31 -0.06 0.06

Unclassified 0.00 0.32 0.00 0.00 2.13 0.32 2.13 0.25 0.32 -0.07 0.07

Unclassified 1.00 25.0000 25.00 0.00 0.00 2.13 2.13 2.13 25.00 25.00 0.00 0.00

Unclassified 0.00 0.50 0.00 0.00 0.32 0.00 0.00 0.50 0.50 0.00 0.00

Unclassified 0.00 1.50 0.00 0.00 2.13 1.50 2.13 0.00 1.50 0.00 0.00

Unclassified 0.00 0.32 0.00 0.00 2.13 0.32 2.13 0.00 0.32 0.00 0.00

Unclassified 0.00 0.31 0.00 0.00 2.13 0.31 2.13 0.00 0.31 0.00 0.00

>

Reporting Invoice Spend with Charges and Taxes 1P3 Save.. Export Actions

Field Browser
Pivot table Chart Dashboard

Page Others

Applied Filters

114.82 Accounting DateSpanning: 4/1/2017 --6/30/2017 Display Options Edit 
Min/Max rows: 3/8

Detail View

[INV] [INV] [INV] [PO] Tax [INV [INV] [INV] [INV] Tax 
[INV] TaxInvoice [INV] Invoice [INV] Invoice DiscountCharge[PO] Tax [INV] Tax Amount Amount Amount Amount Accrual

X Code QuantityUnit Price Spend AmountAmountAmount Amount Invoiced Invoiced Accepted Disputed Amount
Description + (USD) (USD) (USD) (USD) (USD) (USD) (USD) (USD) (USD) (USD) (USD)

Unclassified 0.00 1.50 0.00 0.00 2.13 1.50 2.13 0.25 1.50 -1.25 1.25

Unclassified 0.00 0.31 0.00 0.00 2.13 0.31 2.13 0.25 0.31 -0.06 0.06

Unclassified 0.00 0.32 0.00 0.00 2.13 0.32 2.13 0.25 0.32 -0.07 0.07

    
        

            
             

            

            

            

             

            

            

            

            

      

 
  

  

 

   

 

 
         

          
             

            

            

           



76 Appendix II 

SAP Ariba Reports With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

17. When all steps are completed, excel file will be opened.   

This file can be manipulated further to display data as desired by user. Pivot table can be updated or 

formulas can be added to analyze the data further. Below sample file downloaded from customized report 

showing tax authorities, PO tax Amount vs. Tax amount on Invoice and Tax Accrual data which can be 

further manipulated based on requirement. 

ExportingtoExceltemplate Return to Report

Your data is being exported.If you are asked to enable ActiveX,respond Yes. Otherwise,your data cannot be exported to Excel.

1. Contacting Excel

2.Downloadingtemplate

3. Waiting for query
4.Downloadingdata

5. Configuring layout

6.Done

Return to Report

(Pivot_Area_Pieÿxds:jsessionidBE9D1A52FC19498A3E89DF25E4EBBA71.Node19app212snv [Read-Only] [Compatibity Mode] - Microsoft Excel
Home Insert Page layoutFormulas Data Revlew View
&Cut Arlal 10 xai dem Text ÿ AutoSum

Paste
 Copy

5·%ÿ Cell InsertDelete Format
Format Painter 8 ÿ Clear *

Sort&Find&

Number
Formatting* as Table * Styles*

Editing
Filter* Select *

Clipboard G Font C ÿ

F30 Catalog Item
A ÿ C
[INTotal

E

2 This Worksheet Will Contain Data Populated From Ariba Spend Management.
3 INVInvoice Quanlity [INV] Invoice Unit Price (USD)[INV] Invoice Spend (USD)[INV] Discount Amount (USD) [INV] Charge Amot
4 ToQuery Parameters: Range *Ariba Data Params"
5 Source_Data /nvoice (Procurement&Invoicing);PurchaseOrder (Procurement&Invoicing)

Flxed_Columns FALSE
6
7

Fleld_Mappings
Query_Fllters

8
9 Raw_Fleld_Names SSPlnvoiceLineltem.Supplier.SupplierName,SSPInvoiceLineltem.lnvoiceld,SSPlnvoiceLineltem.AccountingDate.Day,SSPlnvo
10 Sort Flelds
11
12 Data Table: Range “Ariba_Data
13
14 [INVJSuppller (ERP Suppller) [INV] Involce ID [INV]Accounting Date (Date)[INV] Involce Line Number [INV] Line Type
15 IL Ofice Supplies IRRM-05-05-2017-OVER-459 5/8/2017 5 Catalog ltem
16 IL Ofice Supplies IRRM-05-05-2017-OVER-459 5/8/20177 District Sales/Use
17 IL Office Supplies IRRM-05-05-2017-OVER-459 5/8/20173 City Sales/Use
18 IL Ofice Supplies IRRM-05-05-2017-UNDER-460 5/8/2017 2 City Sales/Use
19 IL Ollice Supplies

IL Ofice Supplies
IRRM-05-05-2017-UNDER-460 5/8/2017 4 Distnict Sales/Use

20 IRRM-05-05-2017-OVER-459 5/8/20171
IL Olice Supplies District Sales/Use

Calalog ltem
21 IRRM-05-05-2017-OVER-459 5/8/20174
22 ERS vendor IRv test1111-421 4/25/2017 4 Counly Sales/Use
23 Ofhice Producls GB IRTR VI INV Demo1-370 4/20/2017 1 Catalog ltom
24 Olfice Producls GB IRaccept the engine calculaled tax 352 4/18/20171 Catalog ltem
25 Office Products GB IRVI_Demo_UK_Apr26_1417 4/25/20171 Catalog ltom
26 IL Office Supplies IR123444-333 4/13/20171 Catalog ltem
27 IL Office Supplies IR2345566543-346 4/17/2017 1 Catalog ltem
28 IL Ofice Supplies IR12455-342 4/14/2017 1 Catalog ltem
20 Dÿ GD 420/20171

  

  

 

 

 
 

 

 
 

 

       

 
     

  
    

   
 

 

 
 

 
 

   
  

  
   

 

 

  
    
  
   

  
 
 

 
 

 
  
  
 
  
 
   
  

 
 

   
 

 
   

 
 

     
  

 
   

   
     

   

 

 
     
     
     
     

        
   



Appendix III 77 

SAP Ariba Reports With Tax Data 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

APPENDIX III 
XSD CHANGES TO EXTERNAL WEB 
SERVICES 
When SAP Ariba makes changes to Import/Export Files or Web Services format, Customers need to 
review, accept the changes and publish all changes accepted to apply the changes introduced. This is 
SAP Ariba standard process and also applies to external tax calculation web service task “Export 
Document Data for External Tax Calculation”. 

Please follow below steps to review, accept and publish changes made to task Export Document Data for 
External Tax Calculation. 

1. It is recommended to consult SAP Ariba Customer Support and Thomson Reuters Professional 
Services before making decision to accept XSD changes. And also remember that upgrade 
cannot be reverted back to SAP Ariba Platform limitation on for this feature so careful 
consideration is required before upgrading to new XSD. 

2. New SAP Ariba Buying solutions Customers with solution having Service pack SSP.2017.Rel-
9535/Release Number SSP.2017.09 would have Tax API with new XSD as default so can ignore 
this section. 

[INTotal
ThisWorksheetWill ContainDataPopulatedFromAribaSpendManagement.
[INV] Invoice Quant[INV] Invoice Unit Price[INV] Charge Amou[INV] Amount Accepted(USI [INV] Amount Disputed (USD)

01 QueryParameters:Range"Ariba_Data_Params" Query Details:Rang
Source Data Invoice (Procurement &Invoicing);Purchase Order (Procurement & Invoicing) AppliedFilters
Fixed_ColumnsFALSE Applied_FilterDes

Query_Filters
Field Mappings
Raw_Field _Name SSPInvoiceLineltem.Supplier.SupplierName, SSPInvoiceLineltem.lnvoiceld,SSPInvoiceLineltem.AccountingDate.Day, SSPInvoiceLineltem.InvoiceLineNumber, SSPInvoiceLineltem.LineType, SSPInvoiceLin
Sort_Fields

Data Table: Range"Ariba_Data" Extra (Derived) Colu

[INVJTax
[INV]Supplier [INV]Tax Code (Tax CodeCode (Taxsum(Tax Amount sum(Amount sum(Amountsum(Amount sum(Tax Accrual
(ERP Supplier)[INV] Invoice ID [INV] LineType Name) Code Id) Invoiced) Invoiced) Accepted) Disputed) Amount) Sample
IL Ofice SuppliesIRRM-05-05-2017-OVEI Catalog ItemIDT Standard Output TAXA1 2.48 30.00 30.00 0.00 0.00 add formula here
IL Ofice SuppliesIRRM-05-05-2017-OVEIDistrictSales/UseIDT Standard Output TAXA1 2.48 0.60 0.30 0.30 0.00
IL Office SuppliesIRRM-05-05-2017-OVEICitySales/Use IDT Standard Output TAXA1 412.50 75.00 50.00 25.00 0.00
IL Ofice SuppliesIRRM-05-05-2017-UNDI City Sales/UseIDT Standard Output TAXA1 850.00 200.00 125.00 75.00 0.00
IL Office SuppliesIRRM-05-05-2017-UNDEDistrictSales/Use IDT Standard Output TAXA1 850.00 200.00 125.00 75.00 0.00
IL Office SuppliesIRRM-05-05-2017-OVEICatalogltemIDT Standard Output TAXA1 412.50 5,000.00 5,000.00 0.00 0.00
IL Ofice SuppliesIRRM-05-05-2017-OVEIDistrictSales/UseIDT Standard Output TAXA1 412.50 75.00 50.00 25.00 0.00
ERS vendor IRvi_test1111-421 County Sales/UseUnclassified Unclassified 0.00 0.25 0.25 0.00 0.00
OfficeProductsGEIRTRVIINV_Demo1-3CatalogItemIDT Standard Input TAX V1 125.00 625.00 625.00 0.00 0.00
OfficeProducts GEIRaccept the engine ca Catalog ltemIDT Standard Input TAXV1 225.00 1,125.00 1,125.00 0.00 0.00
Office Products GEIRVI_Demo_UK_Apr26_Catalog ItemIDT Standard Input TAXV1 148.40 742.00 742.00 0.00 0.00
IL Ofice SuppliesIR123444-333 Catalog ItemIDT Standard Output TAXA1 0.00 3,000.00 3,000.00 0.00 0.00

A1 112.50 0.00 0.00

ÿ

 
 

 
   

   
  

 
 

 

  

 
     

           
         
         
         

         
         
         

         
          

        
        

       
         

   



78 XSD Changes To External Web Services 

Reviewing And Accepting Changes 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

REVIEWING AND ACCEPTING CHANGES   

Navigation: 

1. Log in to SAP Ariba Buying Solution

2. On Home screen navigate to Manage > Core Administrator  

3. Go to > Integration Manager > Data Definition > Select Web Services from Format Dropdown menu   

  

and click on Search button

Note: if there are more than one web services configured, user can search for specific task by entering

Export Document Data for External Tax Calculation in Task Name input field

Result: System would display integration task with status Changed

5. Click on Action button and select option Review as shown in the screenshot
  

HOME PROCUREMENT INVOICING USERPROFILE MORE.. Recent Manage Create

Administration PurchasingWorkbench

Payment PaymentID ERPPayment# Supplier Invoice# Purchase Ord ApprovalProcesses Queues

Contracts Receive
Common Actions Core Administration Reconcile ChargesToDo
Create MyTasks ReconcileInvoice
Requisition IDÿ Date From Status

MyToDo ReportSearchFilters
Analytical Report Noitems

Payments SMAdmin
KnowledgeProject

Personal Workspace SupplierKnowledgeSupplier MyDocuments
More PrepackagedReports Unassigned Charges

ID Title Dateÿ
Manage PublicReports

Administration Noitems PurchaseOrders

HOME PROCUREMENT INVOICING ADMINISTRATION MORE... Recent Manage Create T

Data Definition
 Site Manager

Data Import/Export

Audit Log Review and accept changes to the data definition in integration events.

Integration Manager Search Filters:

Data Import/Export Task Name:

Data Definition
Format: Web ServicesIntegration Configuration Search List All

End Point Configuration

Integration Toolkit Security
Data Definition Download Data DictionaryMaster Data Default Values

Tasks Status Format
Master Data Manager

Export Document Data for External Tax Calculation Changed Web Services Actions 
Customization Manager

  

 

 

  

 

  

        

  

       

  
 

   
 

  
     

  
  

  
 

  
  

   

   
  

  

       

 
 

 
 

 

  

  

 
     

 

 
   

   
 

   



XSD Changes To External Web Services 79 

Reviewing And Accepting Changes 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

System would show the list of groups under ‘Export Document Data for External Tax Calculation' 
integration event.   

There would be two groups like ProcureLineItemCollection_TaxServiceAPIRequest and 
ProcureLineItemCollection_TaxServiceAPIResponse which would show the Status as Needs Review 
Publish All Changes in active 

6. Click on group ProcureLineItemCollection_TaxServiceAPIRequest. The section ‘Field Order for   
ProcureLineItemCollection_TaxServiceAPIRequest' would show the fields under this group.   

Scroll down to find the fields marked in red which has been newly added. Here, Organization Unit and   
Organization Name are new fields. Click on Accept Changed Fields button to accept the changes.   

DataDefinition

Review and accept changes to the data definition in integration events.

SearchFilters:

Task Name:

Format: Web Services Search List All

DataDefinition DownloadDataDictionary

Tasks Status Format

Export Document Data for External Tax Calculation Changed Web Services Actions
Review

Export Document Data for External Tax Calculation Publish All Changes Exit

Review and accept the changes for each group of fields that needs review, then publish all changes. You must accept all the changes before publishing.

Groups for 'Export Document Data for External Tax Calculation'

Group Names Status

Money_Reference No Change

ProcureLineltemCollection_TaxServiceAPlRequest Needs Review

ProcureLineltemCollection_TaxServiceAPlResponse NeedsReview

Field Orderfor'Money_Reference'

PositionCurrent Field New Field Description

Amount Amount

2 AmountinReportingCurrency AmountinReportingCurrency

 

 

 

 

    

  

   

    

   

 

 

  

  

  

  

 

    

  

  



80 XSD Changes To External Web Services 

Reviewing And Accepting Changes 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

7. Now click on other group ‘ProcureLineItemCollection_TaxServiceAPIResponse’. System would 
show the fields under this group. Scroll down to find the fields added newly in green color.   

  
LineItems.ExternalTaxItem.AccountInstruction is a new field. Click on Accept Changed Fields   
button to accept the changes. 

8. Finally to make changes effective, click on Publish All Changes button on top (below Application 
Menu bar) as shown in the below screenshot. 

  

ProcureLineltemCollection_TaxServiceAPIRequest Needs Review

ProcureLineltemCollection_TaxServiceAPlResponse Needs Review

Field Orderfor'ProcureLineltemCollection_TaxServiceAPIRequest'

Position Current Field New Field Description

31 Lineltems.SupplierLocation.PostalAddress.State Lineltems.SupplierLocation.PostalAddress.State

32 Lineltems.TaxExclusion Lineltems.TaxExclusion

33 Type Type

34 UniqueName UniqueName

35 OrganizationName

36 OrganizationUnit

Accept Changed Fields

Group Names Status

Money_Reference No Change

ProcureLineltemCollection TaxServiceAPIRequest Needs Review

ProcureLineltemCollection_TaxServiceAPIResponse Needs Review

Field Order for 'ProcureLineltemCollection_TaxServiceAPIResponse'

Position Current Field New Field Description

21 Lineltems.ExternalTaxltem.TaxableAmount.Currency.UniqueNameLineltems.ExternalTaxltem.TaxableAmount.Currency.UniqueName

22 Lineltems.ExternalTaxltem.Accountlnstruction

23 Lineltems.NumberlnCollection Lineltems.NumberlnCollection

24 Lineltems.TaxCode.Country.UniqueName Lineltems. TaxCode.Country.UniqueName

25 Lineltems.TaxCode.UniqueName Lineltems. TaxCode.UniqueName

26 UniqueName UniqueName

Accept Changed Fields

  

 

  

  

 

    

   

   

   

   

  

  

  

  

  

  

 

    

   

  

   

   

   

   



XSD Changes To External Web Services 81 

Reviewing And Accepting Changes 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

9. Once the changes are accepted and published, new fields turn in to red representing that fields were 
added. And field groups shows the status as Changes Accepted 

Finally the data definition main UI page will show you web service task status as unchanged telling you 
that changes available are accepted and no more changes exists. 

HOME PROCUREMENT INVOICNG ADMINISTRATION MORE Recent Manage Create

Export Document Data for External Tax Calculation PublishAllChanges Exit

To revert to the previously accepted data definition, review and accept the reversion changes for each group of fields that needs review, then publish all changes. You must acceptMore

Group Names Status

ProcureLineltemCollection_TaxServiceAPIRequest Changes Accepted

ProcureLineltemCollection_TaxServiceAPlResponse Changes Accepted

Field Order for'ProcureLineltemCollection_TaxServiceAPlRequest

 Position Current Field New Field Description

31 Lineltems.SupplierLocation.PostalAddress.State Lineltems.SupplierLocation.PostalAddress.State

32 Lineltems.TaxExclusion Lineltems.TaxExclusion

33 Type Type

34 UniqueName UniqueName

35 OrganizationName

36 OrganizationUnit

Accept Changed Fields

Groupsfor'ExportDocumentDataforExternalTaxCalculation'

GroupNames Status

ProcureLineltemCollectionTaxServiceAPIRequest ChangesAccepted

ProcureLineltemCollection_TaxServiceAPIResponse ChangesAccepted

FieldOrderfor'ProcureLineltemCollection_TaxServiceAPiResponse

PositionCurrentField NewField Description

21 Lineltems.ExternalTaxltem.TaxableAmount.Currency.UniqueName Lineltems.ExternalTaxltem.TaxableAmount.Currency.UniqueName

22 Lineltems.ExternalTaxlitem.Accountinstruction

23 Lineltems.NumberlnCollection Lineltems.NumberinCollection

24 Lineltems.TaxCode.Country.UniqueName Lineltems.TaxCode.Country.UniqueName

25 Lineltems.TaxCode.UniqueName Lineltems.TaxCode.UniqueName

26 UniqueName UniqueName

        

   

 

  

  

  

 

    

   

   

   

   

  

  

 

  

  

  

 

    

   

  

   

   

   

  



82 XSD Changes To External Web Services 

Update Endpoint 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

UPDATE ENDPOINT 
In addition to upgrading to new XSD, Customers also need to update the end point URL for 
ONESOURCE Tax Web Service. 

Users must be a member of Customer Administrator or Integration Admin to perform this activity. 

To update endpoint URL, please follow below steps: 

1. Log in to SAP Ariba Solution 

2. Manage > Core Administrator > Integration Manager > End Point Configuration 

DataDefinition

Review and accept changes to the data definition in integration events.

SearchFilters:

Task Name.

Format: Web Services Search List All

DataDefinition DownloadDataDictionary

Tasks  Status Format

Export Document Data for External Tax Calculation Unchanged Web Services Actions

HOME PROCUREMENT INVOICING CATALOG MORE... Recent- Manage Create T

Administration Purchase Orders

Payment Payment ID ERP Payment # Supplier Invoice # Purchas Approval Processes Queues

Contracts Receive

Common Actions
To Do Core Administration Reconcile Charges

Create My Tasks Reconcile Invoice

Requisition ID ÿ Date From Status
My To Do Report Search Filters

Analytical Report No items
Payments Supplier Knowledge

Supplier
Personal Workspace Unassigned Charges

Customer My Documents
More Prepackaged Reports

ID Title Date ÿ
Manage Public Reports

  

 

 

 

 

    

  

   

   

        

  

       

  

 
 

  

   
     

  
  

  
 

   
 

 
   

 



XSD Changes To External Web Services 83 

Update Endpoint 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

3. Find endpoint to be updated and select Search

4. When user clicks on Edit, system would offer endpoint UI in edit mode.

5. Once Endpoint URL has been update click Save to complete the update.

HOME PROCUREMENT INVOICING ADMINISTRATION

Recent Manage Create 
MORE...

Integration Manager
Site Manager

Data Import/Export
s   g n    o  e n n n Audit Log

Integration Manager Data Import/Export Data Definition
Data Import/Export

Import and export data. View status, details, errors, and Review and accept changes to the data definition in
Data Definition the history of past data imports and exports. integration events.
Integration Configuration

End Point Configuration Integration Configuration EndPointConfiguration

Integration Toolkit Security Search, edit, activate or deactivate data import/export Configure external systems connection information.

Master Data Default Values tasks. Search fields are case-insensitive and you can enter
all or part of a name.

HOME PROCUREMENT CATALOG ADMINISTRATION MORE... Recent Manage Create T

End Point Configuration
SiteManager

Data Import/Export
Audit Log Search for existing end points or create new end points. Search fields are case-insensitive and you can enter all or part of a name.

1.enter search
Integration Manager text (case insensitive)
Data Import/Export Search Filters: 2. select Add/Remove Search Filters

Outbound as TypeData Definition End Point: indirect
Integration Configuration
End Point Configuration Type. No Choice Inbound Outbound

Search List All
Integration Toolkit Security

3. clickMaster Data Default Values 4. system would Searchdisplay endpoint
Master Data Manager

Name Type
Customization Manager IndirectTax punoqno

User Manager Create New 5.click Edit
Users

End Point Configuration-EditEnd Point"lndirectTax' Save Cancel

2. click
Save

General

Specify end point information and specify either a Web Services Security certificate, an HTTP Authentication, none of them or both. Fields marked with * are required.

Name. IndirectTax 1.enterherethenew
endpoint

Type. Inbound punoqno

URL: 1omsonreuters.com/ExternalTRTaxService/TaxServiceExport/TaxServiceExport.wsdl

 

 

 

    

  
 

 
 

 

 

   
 

  
   

 

 
  

   

  

      

 
 

 
 

 

 
  

    
    

 
    

  
 

   
 

 
   

   

   

   

 
 

 

 

   
 

   

 



84 XSD Changes To External Web Services 

Update Endpoint 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

Please check with Thomson Reuters Professional Service for updated end point URL 

Updating endpoint also updates endpoint URL for integration event Export Document Data for 
External Tax Calculation 

6. Verify if endpoint URL updated in Integration Task by following below steps

  
1. Manage > Core Administration > Integration Admin > Integration Configuration
2. Under Search Filters section, select ONESOURCE Endpoint from drop down menu and choose Status

Enabled.

3. Click on the task Export Document Data for External Tax Calculation hyper link shown under the 
Configuration section to check the updated endpoint URL.
4. Verify if this URL is similar to what has been entered for.
5. Select Done.

  

ÿ

Integration Manager
Data Import/Export Search Filters:

Data Definition

Integration Configuration Task Name:

End Point Configuration 1. choose endpoint
Format: (no value) created forIntegration Toolkit Security 2.select ONESOURCEintegration

Master Data Default Values check box End Point: IndirectTax
for Enabled

MasterData Manager Status: Enabled Disabled Search List All

Customization Manager

3.system would
User Manager Configuration display integration
Users task

Other User Info Tasks ÿ Format Enabled Supported Formats

Groups Export Document Data for External Tax Calculation
Web

Exports data on approvable documents (such as requisitions and invoice YesService [Web Service] Actions 1
Approval Queues reconciliations) to the external system for calculation of tax.

Data Import/Export
Delegations

  

 

 
  

 

 

  

 

  

  
    

  
    

 
      

 

 
   

  

    

  
    

  
  

 



Appendix IV 85 

Work around for Repeated Tax Authority Issue 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

APPENDIX IV 
WORK AROUND FOR REPEATED TAX AUTHORITY 
ISSUE 
ISSUE 
This issue is only seen on SAP Ariba Invoice Reconciliation document for transactions involving taxation 
by U.S. Tax regime. For some U.S. Tax scenarios there would be more than one tax authority at same tax 
jurisdictional level charging tax on purchase transactions. For instance in case of a purchase transaction 
with ship to as CO location there would be two tax authorities at District level charging tax. 

CO - SCIENTIFIC AND CULTURAL FACILITIES DISTRICT (EXPANDED), DISTRICT SALES/USE TAX 
CO - REGIONAL TRANSPORTATION DISTRICT, DISTRICT SALES/USE TAX 

ONESOURCE Global Tax for SAP Ariba Solutions sends tax type as “District Sales/Use” for both tax 
authorities in the tax call response. SAP Ariba considers tax amount on both levels on Requisition 
captures total tax correctly. But on Invoice Reconciliation, it only captures the tax amount from one of the 
tax authorities. This results in incomplete or partial tax being charged and in turn results in reconciliation 
exception due to variance in tax amount between Requisition and Invoice Reconciliation documents 

View data import/export task Done
2.click Done

Activate or deactivate task, specify integration format and connectivity information.

Name: Export Document Data for External Tax CalculationView WSDL

Description: Exports data on approvable documents (such as requisitions and invoice reconciliations) to the external

system for calculation of tax.

Status:  Enabled

Format:Web Service

Type: Outbound to External System

End point:  IndirectTax 1. verify if this URL is similar to
whathasbeenenetered for

URL: * https://int-ariba-

uat.hostedtax.thomsonreuters.com/ExternalTRTaxService/TaxServiceExport/TaxServiceExport.wsdl

  
 

 

   

  

 

  

  

  

  
 



86 Appendix IV 

Tax Types and Tax Type Mapping data update 

ONESOURCE GLOBAL TAX FOR SAP ARIBA SOLUTIONS VERSION 1.0.0.0 
CONFIGURATION GUIDE 

SOLUTION 
While SAP Ariba is considering a permanent solution, Thomson Reuters ONESOURCE is providing a 
workaround with maintenance release 1.0.1.0. This involves programmatic fix to ONESOURCE 
integration solution and tax master data update in SAP Ariba Buying Solution. 

Please see below table to know who need to do what kind of action as part of fix based on solution 
deployment model: 

Integration Deployment Model Software Upgrade SAP Ariba Tax Master Data 
Update 

Cloud Customer No action required 

Tax Type and Tax Type 
Mappings data need to be 
updated.   

See below section Tax Master 
Data Update 

On-Premise Customer with 
ONESOURCE Global Tax for SAP 
Ariba Solutions with v. 1.0.0.0 and  
higher 

Upgrade required. Please see 
instructions documents 
available in Platform Support 

Tax Type and Tax Type 
Mappings data need to be 
updated. 

See below section Tax Master 
Data Update 

TAX TYPES AND TAX TYPE MAPPING DATA UPDATE 
Customer need to update Tax Types and Tax Type Mapping data in SAP Ariba Buying Solution as part of 
the fix. This section explains the procedure to update required master data. 

1. Please use the data provided here to prepare import CSV file in to SAP Ariba Solution. 

2. User needs to be member of Customer Administrator group to perform the data update. 
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I. Tax Types Master Data Update:  
Import Task Name: Import Tax Types | Import CSV File Name: TaxTypes.csv 

UTF-8 

UniqueName Name Category 

City Sales/Use_1 Sales or use taxes levied by a city_1 2 

City Sales/Use_2 Sales or use taxes levied by a city_2 2 

City Sales/Use_3 Sales or use taxes levied by a city_3 2 

City Sales/Use_4 Sales or use taxes levied by a city_4 2 

City Sales/Use_5 Sales or use taxes levied by a city_5 2 

County Sales/Use_1 Sales or use taxes levied by a county_1 2 

County Sales/Use_2 Sales or use taxes levied by a county_2 2 

County Sales/Use_3 Sales or use taxes levied by a county_3 2 

County Sales/Use_4 Sales or use taxes levied by a county_4 2 

County Sales/Use_5 Sales or use taxes levied by a county_5 2 

District Sales/Use_1 District sales or use taxes not applied by political boundaries_1 2 

District Sales/Use_2 District sales or use taxes not applied by political boundaries_2 2 

District Sales/Use_3 District sales or use taxes not applied by political boundaries_3 2 

District Sales/Use_4 District sales or use taxes not applied by political boundaries_4 2 

District Sales/Use_5 District sales or use taxes not applied by political boundaries_5 2 

State Sales/Use_1 Sales or use taxes levied by a state_1 2 

State Sales/Use_2 Sales or use taxes levied by a state_2 2 

State Sales/Use_3 Sales or use taxes levied by a state_3 2 

State Sales/Use_4 Sales or use taxes levied by a state_4 2 

State Sales/Use_5 Sales or use taxes levied by a state_5 2 

II. Tax Type Mappings Master Data Update:
Import Task Name: Import Tax Type Mappings | Import file Name: TaxTypeMap.csv 

UTF-8 
TaxLineType Name 
City Sales/Use_1 Sales or use taxes levied by a city_1 
City Sales/Use_2 Sales or use taxes levied by a city_2 
City Sales/Use_3 Sales or use taxes levied by a city_3 
City Sales/Use_4 Sales or use taxes levied by a city_4 
City Sales/Use_5 Sales or use taxes levied by a city_5 
County Sales/Use_1 Sales or use taxes levied by a county_1 
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County Sales/Use_2 Sales or use taxes levied by a county_2 
County Sales/Use_3 Sales or use taxes levied by a county_3 
County Sales/Use_4 Sales or use taxes levied by a county_4 
County Sales/Use_5 Sales or use taxes levied by a county_5 
District Sales/Use_1 District sales or use taxes not applied by political boundaries_1 
District Sales/Use_2 District sales or use taxes not applied by political boundaries_2 
District Sales/Use_3 District sales or use taxes not applied by political boundaries_3 
District Sales/Use_4 District sales or use taxes not applied by political boundaries_4 
District Sales/Use_5 District sales or use taxes not applied by political boundaries_5 
State Sales/Use_1 Sales or use taxes levied by a state_1 
State Sales/Use_2 Sales or use taxes levied by a state_2 
State Sales/Use_3 Sales or use taxes levied by a state_3 
State Sales/Use_4 Sales or use taxes levied by a state_4 
State Sales/Use_5 Sales or use taxes levied by a state_5 

Tax Type and Tax Type Mapping import is SAP Ariba standard process. For detailed description of 
import CSV file preparation and import process, please refer Import Tax Types and Import Tax Type 
Mappings section in this document. 
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